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Copyright and Trademarks 
Copyright © 1995, 2013, Oracle and/or its affiliates. All rights reserved.  

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation 
of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated 
software, any programs installed on the hardware, and/or documentation, delivered to U.S. 
Government end users are "commercial computer software" pursuant to the applicable Federal 
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, 
disclosure, modification, and adaptation of the programs, including any operating system, integrated 
software, any programs installed on the hardware, and/or documentation, shall be subject to license 
terms and license restrictions applicable to the programs. No other rights are granted to the U.S. 
Government.This software is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications, 
including applications which may create a risk of personal injury. If you use this software in 
dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of this software. Oracle Corporation and its 
affiliates disclaim any liability for any damages caused by use of this software in dangerous 
applications. 

Oracle and Java are registered trademarks of Oracle Corporation and/or its affiliates. Other names 
may be trademarks of their respective owners. 

This software or hardware and documentation may provide access to or information on content, 
products and services from third parties. Oracle Corporation and its affiliates are not responsible for 
and expressly disclaim all warranties of any kind with respect to third party content, products and 
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages 
incurred due to your access to or use of third party content, products or services. The RMW product 
includes software developed by the Visigoth Software Society.  
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Preface 
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) web site http://www.oracle.com/technetwork/documentation/agile-085940.html 
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 
from the web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe web site http://www.adobe.com. 

The Oracle Technology Network (OTN) web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help 
> Manuals in both Agile web Client and Agile Java Client. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.. 
Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program 
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.. Oracle provides dedicated 
Text Telephone (TTY) access to Oracle Support Services within the United States of America 24 
hours a day, 7 days a week. For TTY support, call 800.446.2398. Outside the United States, call 
+1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) web site http://www.oracle.com/technetwork/documentation/agile-
085940.html. 

Agile Training Aids 

Go to the Oracle University web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to web sites of other companies or organizations that Oracle 

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these web sites.  
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Chapter 1 

What's New in Agile PLM 9.3.1 
This chapter includes the following: 

 Install and Test Notice ......................................................................................................................................... 1 
 Hot Fixes Included in this Product Release ......................................................................................................... 1 
 Accessing Agile PLM Documentation .................................................................................................................. 1 
 Oracle Software Delivery Cloud Download Checklist .......................................................................................... 2 
 Oracle Agile Product Overview Checklist ............................................................................................................ 3 
 New Features in Agile PLM Solutions ................................................................................................................. 4 

This chapter contains important information about this product release and lists new features 
available in this release. 

Install and Test Notice 
Important Install and test this release on a designated development server before installing it on 

your production environment. Your development environment should mirror your 
production environment as closely as possible to provide accurate testing results. It is 
important to validate the installation of this release, and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions 
noted during your development system testing should be resolved before installing this 
release on your production environment. 

Hot Fixes Included in this Product Release 
Note The contents of this release include the following Patches (HotFixes):  

Oracle Agile PLM Release 9.2.1.4 HotFix 29; 
Release 9.2.2.1  HotFix 44; 
Release 9.2.2.2  HotFixes 43, 45; 
Release 9.2.2.3  HotFix 53; 
Release 9.2.2.4  HotFixes 60, 65, 67–69, 71–73; 
Release 9.2.2.5  HotFixes 7, 34, 45, 48–50, 53, 55–58; 
Release 9.2.2.6  HotFixes 23, 26, 27, 29, 30, 33, 34, 36, 37, 40–44; 
Release 9.2.2.7  HotFixes 1, 3, 4, 6, 8, 10–14; 
Release 9.3.0.0  HotFixes 12, 13, 15, 18, 20–22, 24, 25; 
Release 9.3.0.1  HotFixes 1–4, 6–13, 15–18, 20, 22, 24–29, 31. 

 

Accessing Agile PLM Documentation 
PLM Solution and Administration Manuals 
Please use this Web site to access your Agile PLM 9.3.x documentation, which includes manuals 
about installing PLM, configuring and administering PLM, and all the PLM solutions for users: 
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http://www.oracle.com/technetwork/documentation/agile-085940.html  

Note The documentation of Agile PLM 9.3.x is no longer accessed through Metalink.  

 
 

PLM Sample Code and Scripts 
Sample code and scripts pertaining to Agile solutions may be found on the Oracle Agile PLM 
Sample Code page: 

http://www.oracle.com/technetwork/indexes/samplecode/agileplm-sample-520945.html 

Oracle Software Delivery Cloud Download Checklist 
Oracle products are distributed as "Product Packs". A Product Pack is an electronic version of the 
software. Refer to the Media Pack description or the list of products that you purchased on your 
Oracle Ordering Document.  

Then, view the Quick Install Guide License List to help you decide which Product Pack you need to 
select.  

Prior to downloading, verify that the product you are looking for is in the License and Options 
section of the Product Pack README.  

Oracle recommends that you print the README for reference. 

Please download each Product Pack from the Oracle Software Delivery Cloud web site 
(http://edelivery.oracle.com/) as specified below. 

1. Oracle Agile PLM Application Components 

2. Oracle Application Server     

3. Oracle Database     

There will be an itemized part list within each of the packs. You will need to download all items in 
order to have the complete download for the desired Oracle Agile release. 

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly portable Zip 
utility. After downloading one or more of the archives, you will need the UnZip utility (for UNIX or 
Windows platforms) or the WinZip utility (for Windows platform) to extract the files. You must unzip 
the archive on the platform for which it was intended.  

Verify that the file size of your downloaded file matches the file size displayed on Oracle Software 
Delivery Cloud.  

Unzip each Zip file to its own temporary directory. 

For example, create a directory structure called oraAS10g on your hard drive: 

c:\oraAS10g 

Then create a new directory for each Zip file you downloaded: 

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/indexes/samplecode/agileplm-sample-520945.html
http://edelivery.oracle.com/
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c:\oraAS10g\Disk1 

c:\oraAS10g\Disk2 

After extracting the software from the Zip files, you can install from your computer's hard drive. 
 

Oracle Agile Product Overview Checklist 
After reading the content of this Oracle Agile PLM release document, we suggest performing the 
following tasks: 

 Feature Review: 
 Review the New Features and Resolved Issues sections to make sure you understand the 

overall product changes in this release. 

 Business Process Review: 
 After completing the New Feature and Resolved Issues review, make sure you understand 

if any of your current business processes are impacted by this release and/or if they might 
need to be modified and re-evaluated.  This is a very important preparation step as you 
move forward with implementing any Agile release. Make sure all of your key business 
processes are thoroughly documented and you have an overall business owner who 
understands each process. Use this list of processes as a checklist against the features 
and changes in this Agile release. You may want to assign a “weight” to each change in 
terms of how significant an impact it has to your organization (think about re-training users, 
changing current integrations, etc.) 

 Identify resources to install and test this release. 
 Make sure that a test environment is ready and that tests have been developed to ensure 

this release performs the functions necessary for your business. Verify that the system can 
be rolled back in the unlikely event of a failure. Make sure that your testing includes all 
aspects of the product features, all of your business processes and any integration that 
you may have (AIS, SDK, ChangeCAST, ACS, etc.). If considering switching to LDAP 
authentication, come up with a plan to test the LDAP integration. Make sure to cover 
common scenarios like changing password, removing a user, etc. 

 Create an upgrade plan and strategy. 
 For a release, we recommend engaging our Oracle Consulting Organization for your 

upgrade. Validate the hardware configuration according to the Capacity Planning Guide. If 
you plan to manage your own upgrade, create a very detailed upgrade plan that includes a 
scheduled start time, an established number of “dry” runs, a pre-determined rollout date, 
and a designated team of individuals across your organization with detailed knowledge of 
product, technology, networking, business process, etc. 

 Prepare end-user training. 
 We recommend exposing a number of your power users to the new version well in 

advance of a production rollout to ensure that your users deeply understand the product 
functionality. Much of the end user training will actually begin during the testing phase. Use 
this feedback as a basis for your overall end-user training. 
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New Features in Agile PLM Solutions 
The following sections list features that have been added to various Agile PLM solutions in the PLM 
9.3.1 product release. 

Recipe & Material Workspace 
New Solution for Pharmaceutical Development Process 

Agile Product Lifecycle Management (PLM) introduces Recipe & Material Workspace (RMW). The 
RMW solution enables biotechnology and pharmaceutical development companies to create 
products as well as improve business productivity, visibility, scientific outcomes, and proactive 
compliance during the product development lifecycle. RMW contains the following features: 

 Preclinical and clinical supply development; 

 Electronic Development Record (eDR) management; 

 Environmental Compliance and Technology Transfer management; 

 Material Business Processes: 
 Create new Material (chemicals, excipients, buffers, media, solvents, consumables); 
 Supplier qualification; 
 Create lots, containers; 
 Allocation and order release to Process or Campaign; 
 Lot release management; 
 Lot genealogy – raw materials to final product; 
 Raws, intermediates, consumables all viewed and used on a BOM/Work Request. 

 Equipment Business Processes: 
 Create new Equipment and organize equipment; 
 Equipment to Material Trace – which equipment made or stored a bad lot; 
 Preemptive – cleaning and qualification of equipment for a Process; 
 Activity logs – implement electronic tracking to replace paper logs; 
 Reserve equipment for Process; 
 Keep track of current location (move, loan, lease). 

 Recipe Business Processes: 
 Users create new Recipes using actions and elements; 
 Recipe Library enables maximum future reuse and a standards-based approach to writing 

recipes; 
 Each Action and Element have embedded generic resource names (material, equipment, 

standards, etc.), which typically remain unresolved until the Recipe is used in a 
Project/Campaign; 

 Once Recipe is instantiated as a Process Step and resources are resolved (using 
resources that are available at that facility or site), BOM and BOE (Bill of Equipment) is 
automatically created in the Process Step; 
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 Users can continue to version Recipes based on feedback from Pilot Plant or Commercial 
Operations. 

 Project/Campaign Business Processes: 
 Users create new Projects if they want to track any work being done in labs, pilot plants, or 

development areas; examples of types of work that are tracked: making material, cleaning; 
 Project/Campaigns also enables future reuse and a structured approach to completing 

Work Requests; 
 Recipe is used in a Project/Campaign at the Process Step Level, and resource 

placeholders are resolved (using resources that are available at that facility or site); 
 BOM and BOE are automatically created in the Process Step and carried over to Control 

Recipe and the Work Request; 
 Using the Work Request, users can log all work completed, all materials made, all results 

captured; thus, the material made is entered into Inventory; 
 Material coming into Inventory is released formally through the Lot Release Process. 

 Experiment Processes: 
 Users create new projects if they want to track any work being done in labs, or 

development areas, making small amounts of Materials for experimentation and early 
analysis; 

 In this case, Projects just directly track Work Requests or Experiments conducted, and the 
measured results; emphasis is placed on the material quality affecting output quality; 

 Recipe is used in a Project/Campaign at the Process Step Level, and resource 
placeholders are resolved (using resources that are available at that facility or site); 

 BOM is automatically created in the Control Recipe and carried over to the Work Request; 
 Large Equipment is tracked by users who are interested in the genealogy view that 

focuses on material moving from one Equipment-type container to another, and test results 
of the Material at that point in time;  

 Using the Work Request, users can log all work completed, all materials made, all results 
captured; thus, the material made is entered into Inventory; 

 Material coming into Inventory is released formally through the Lot Release Process. 

 
 

Engineering Collaboration 
Document Management 

 Visibility of key Design attributes has been extended on the Design Structure and Where Used 
tabs, the Design Quick View dialog, and Item Attachments tabs referencing Designs. 
 Structure and Where Used tabs: Revision, Revision Date 
 Quick View dialog: Lifecycle Phase, Label, Component Type, Revision, Revision Date 
 Item Attachments tab: Label, Revision, Revision Date (the last 2 are not visible by default) 

 A separate “Copy Files To Rev - Designs” SmartRule is available for Designs, distinct from File 
Folders. This permits the handling of file attachments on pending Item revisions to be treated 
differently for basic doc management use cases, compared to EC CAD file management. 
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 A switch on the Design Where Used tab allows toggling on or off the display of version history for 
where-used parent Designs. Now by default, only the latest version of each where-used Design 
is listed. 

 The Version selector has been extended to include the Revision field. In the standard EC 
process, the Revision field is more recognizable to the user and now they can see this directly 
when selecting the version. 

 Design objects are supported by the Navigator pane, which is used to display an indented tree 
structure in the left region of the web client. 

 A Structured Get function allows entire CAD assemblies to be easily extracted from PLM as a ZIP 
file containing all component files.   

 When using Routing Slip signoff for Designs, both the “Workflow Routings” tab and searches 
pertaining to signoff have been improved. 

 “Approval Status” attribute has been added to all File Folder objects, including Designs, which 
provides much better ability to search on approval status and to define privilege criteria. 

 “Item Change Status” attribute has been added to all File Folder objects, including Designs, which 
is used by the EC change process to indicate the change status of Parts associated to 
Designs. 

Document Management 

 “Open” function always uses the client-side application to open the selected file, regardless of 
AutoVue settings. This is a button available from business object Attachments tabs as well as 
the Files tab of File Folders. 

 
 

Variant Management 
Variant Management (VM) is an extension to Product Collaboration, and was introduced in Agile 
PLM 9.3 as a limited availability patch. The features below include some of the capabilities 
introduced in 9.3, as well as enhancements added in the present release, PLM 9.3.1. 

 Part Subtype – Models and Option Classes contain the field Part Subtype on Title Block tab; this 
field indicates whether the object is a model or option class, independent of its name.  

 Instances Tab – Only the object Model contains the Instances tab which contains a table that 
links to the Instance BOM (this data was moved out of the Relationships tab); the Instance 
Manager is launched from a model's Instances tab by clicking the Launch Configurator button. 

 Propagate Instance Revision – Opens a window that lists all Instance revisions for all previous 
Model Option BOM revisions; selecting an Instance revision from this list copies its 
configuration to the Instance of the current Model Option BOM revision. 

 Check Model Option BOM – The More menu of the Model BOM tab contains the menu selection 
Check Model Option BOM; this option allows an initial check of the current Model Option BOM 
against the allowed combination rules. 

 Variant Management specific Event types – The following event types have been added for Variant 
Management; for more detailed information about the VM event types, see Agile PLM 
Administrator Guide and Agile Product Collaboration User Guide.  
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 Create Variant Instance 
 Derive Variant Model Option BOM 
 Update Variant Configuration 
 Validate Variant Configuration 
 Validate Variant Instance Selections 
 Validate Variant Model Option BOM 

 Searches – Advanced Search allows searching for specific part subtypes: 
 Model 
 Option Class 
 Part 

 Export / Import aXML files – The exported and imported aXML file also contains the Configuration 
Graph information.  

 

Common Services 
 "No Privilege" fields can be hidden; 

 PageOne, PageTwo attribute visibility can be controlled at subclass level; 

 Visibility and order of tabs can be configured by user group or user; 

 Maximum database records to processes for search; 

 Inactive list values in searches can be hidden. 
 

Product Collaboration 
 Configurable Approval Password requirement; 

 Populate default Change Analyst in Workflow; 

 Allow a Workflow to contain multiple Hold and Cancel statuses; 

 Next Status button can move to any valid status; 

 Does not validate entry criteria against Completed or Canceled changes when modifying an 
Item; 

 Visual indication in Item tables for active Stop Ships and Deviations; 

 Enhanced Change History and Pending Changes tables on Items. 

 
 

Product Portfolio Management 
Advanced Scheduling & Resource Management: 

 Fine-grain duration of Activities (minutes or seconds); 

 Allocation of Resources percentages can be entered in fractional value; 
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 Added Web services that enable integration with alternate scheduling engines (in Primavera 
only); 

 Added 15 Dashboard multilist fields: one is named Program out-of-the-box; the other 14 are 
flex fields (renamable) called Category11, Category 12, Category 13, and continuing through 
Category 24. 

 
 

Product Cost Management 
Improved Sourcing Analysis and Price Models: 

 Comprehensive set of actions on Analysis tab; 

 Filter, sort on multiple columns to quickly get to the right data; 

 Multi-column filtering to better track RFQ responses; 

 Configurable Cost rollups via MS-Excel. 
 

Product Governance and Compliance 
 Import substances data (Bill of Substances) to Declaration via Microsoft Excel – compliance 

information that is sought by a Declaration can be collected in an MS-Excel 2003 spreadsheet, 
then imported into the Declaration; 

 Transformation files are used to resolve differences between names when importing 
compositions via IPC PDF forms or JGPSSI forms. 

 

Agile Technology Platform 
Web Services, Oracle Stack Support, and Performance: 

 More complete feature coverage for Web services; 

 Support for Oracle Access Manager (SSO), and Oracle Internet Directory (LDAP); 

 Support for Windows NTLM (SSO) with WebLogic. 

 Control maximum number of records to process when running a search. 

Document Publishing – dynamic publishing of product information: 

 Automatically refreshed product datasheets, parts list, service manuals with PLM data; 

 Integration with popular authoring tools, such as Microsoft Word; 

Improved Security & IP Protection: 

 Force users to change password; 

 Control password expiry duration, enforce strong passwords; 

 Granular control over administrative privileges; 

 Supplier authentication against LDAP; 
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 New Export privilege to prevent export of attachments. 

 
 

Integration 
SDK: 

 Variant Management Event Types; 

 Creating Agile sessions in cluster environments; 

 Creating Criteria-based lists; 

 Creating users and requiring password modification at login;  

 Checking for expired passwords;  

 Approving or rejecting changes without a password; 

 Adding Items from Product Collaboration to Sourcing Projects; 

 Generating a Project's Assembly Cost Report; 

 Setting Start and End timestamps for PPM Date attributes. 
 

Agile Import–Export: 

 Import can process files created using MS-Excel 2007 format .XLSX extension.  

 Export can be done with or without attachments;  

 Administrator Preference Maximum number of objects to export controls exportable objects.  

 
 

Administration 
 Agile Recipe & Material Workspace (RMW) is a significant addition to the PLM suite of enterprise 

solutions. The configuration of the RMW solution begins in PLM Administrator, then is furthered 
and managed by its own administrative capability within Web Client.  

Settings in PLM Administrator to configure RMW begin with:  
 Administrator privilege mask AppliedTo selection, "Recipe & Material Workspace Admin";  
 Privilege mask, "Recipe & Material Workspace UI Access", and privilege type, "Recipe & 

Material Workspace Access";  
 Items subclasses called Material Subclass and Recipe. 

 Event Types for Variant Management added:  
 Create Variant Instance 
 Derive Variant Model Option BOM 
 Update Variant Configuration 
 Validate Variant Configuration 
 Validate Variant Instance Selections 
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 Validate Variant Model Option BOM. 

 Account Policy node has an additional field for Maximum Password Age and new Password 
Rules. 

 Dynamic Lists available based on criteria. 

 Item subclasses of Model and Option Class have been added. 

 Oracle Access Manager (OAM) support for SSO 

 Another certified LDAP server is supported: Oracle Internet Directory (OID) Server. 

 The Export privilege is now divided in two: Export and Export Without Attachments. 

 The AppliedTo attributes for the Administrator privilege mask have been expanded to include 
several more attributes. 

 A Workflow status property, Password Required, is available to regulate approvals with or 
without a password entry. 

 A Display No Privilege Fields privilege to regulate who can see attributes on an object 
according to privilege assignments. 

 There is a Change Password Upon Next Login option to force a user to change their password 
the next time the user logs in to Agile. 

 Tab Display Configuration node is added to Web Client Administrator.  
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Chapter 2 

Resolved Issues 
This chapter includes the following: 

 Key_Resolved Issues_line 1 & 2 ......................................................................................................................... 11 
 Install and Upgrade .............................................................................................................................................. 11 
 Administration ...................................................................................................................................................... 11 
 Integration ............................................................................................................................................................ 14 
 Common Services ............................................................................................................................................... 17 
 Product Collaboration .......................................................................................................................................... 19 

This chapter lists issues that were resolved during this release.  
 
 

Key_Resolved Issues_line 1 & 2 
For each resolved issue: 

 On the first line, the number is the internal Defect number. 

 On the second line, numbers in bold (for example, 3-123456789) are Customer Support ID 
numbers from customer-reported issues. 

 

Install and Upgrade 
9176201 

3-1159506611 

Agile Installer 

Issue: Multi WebLogic JVM support per physical server. 

Root Cause: Feature did not exist previously. 

Resolution: Have support of multiple Weblogic/Agile "homes" running on a single box. 

Verification Steps:  

1. Install Weblogic cluster in either of these configurations: 

    a. One Administrator server, two managed servers in one machine; or,  

    b. More than one managed server in one machine. 

2. Bring up the Agile application in cluster. 



Readme  
 

 

12 Agile Product Lifecycle Management 

  

Administration 
7613218 

2-3873063; 7221400.994 

Administration/Configuration 

Issue: Unable to create user groups and restrict access to LDAP node. 

Root Cause: Historically the Administrator privilege has granted some implicit access to administrate 
Agile PLM.  With 9.3.1, new AppliedTo fields have been added which allow customers to explicitly 
grant rights by configuring Administrator privilege masks. 

Resolution: Add additional Administrator AppliedTo privileges. Added LDAP has an Administrator 
privilege. This controls access to the LDAP node in the Java Client. 

Verification Steps:  

1. Create a role called "role-Test" and assign the following privileges: 
 Create User group 
 Discover User group 
 Modify User group 
 Read User group 

Create new Administrator privilege with AppliedTo only User Group and Deleted user groups. (Do 
not apply LDAP in AppliedTo.) 

2. Assign this role to User A. 

3. User A logs in to Java Client. 

4. Go to User Group node. 

Expected Results: 

1: User A can create Global User group. 

2. User A does not have access to LDAP node in Java Client. 

8340214 

20818228.6 

Administration/Configuration 

Issue: There is no option to require database users to change their password. 

Root Cause: Per customer request, we added this module enhancement in 931. 

Resolution: Force User to change password on their next login. 

Verification Steps:  
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1. Log in as Administrator. 

2. Make sure there is a checkbox "Change password upon next login" when creating a user. 

3. Make sure there is a checkbox "Change password upon next login" when using save as to create 
a user. 

4. Make sure there is a check box "Change password upon next login" when resetting 
password/account for a user 

5. Make sure there is a menu "Change password upon next login" when select one or multiple users 
and click the toolbar. 

8647278 

2-3074852; 7574079.994 

Administration: Users & User Groups 

Issue: Account Policy - missing options 

Root Cause: Per customer request, we need to enhance account policy to improve user experience. 

Resolution: Add new policies under Account Policy node to support enhance account policy. 

Verification Steps:  

1. Log in to Java Client > Account Policy. 

2. Check if there are the following new options: 

   a. Maximum Password Age: 

     .Password Never Expires 

     .Expires in "x" Days 

   b. Password Rules: 

     .At Least One Numeric Character 

     .At Least One Special (Punctuation) Character 

     .At Least One Lowercase Character 

     .At Least One Uppercase Character 

     .Must Not Contain User ID 

     .Minimum Number of Rules Matched 

3. Set a password during creation, save as and reset password/reset account. Check if there is 
error message when the password does not match password rules. Make sure you can set a 
password that matches the Account Policy. 
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9359011 

Administration/Configuration 

Issue: Create new Event in Administrator creates a duplicate API name. 

Root Cause: When creating an Event, the APIName (925) property is added to the property table 
twice. 

Resolution: Just add to the property table once when creating event. 
 

Integration 
In Import-Export, four Agile issues (from multiple Service Requests) with single resolution: 

Agile 7049050 > Customer SRs 18953012.6; 18959914.6; 18963822.6; 2-3432784; 2-3555427; 3-1643418971 > 
Issue: New feature: break Export privilege into two: regular Export for text/Excel, and new privilege 
for PDX. 

Agile 7083211 > Customer SRs 18957490.6; 2-4314339 > Issue: Export privilege/PDX generation. 

Agile 7100097 > Customer SRs 19010540.6; 2-3997098 > Issue: How to restrict Attachments in Export 
feature. 

Agile 9833812 > Customer SR 3-1854668821 > Issue: Export PDX Package circumventing limited 
GetFile Privileges. 

Root Cause: Enhancements 

Resolution: Added "AppliedTo" to Export Privileges that should provide the ability to Export with and 
without attachments. The "AppliedTo" has a single option, "Attachment". If "Attachment" is in the 
Selected list of AppliedTo, the user can export attachments, otherwise the attachments are not 
exported. Also, the checkbox options related to Attachments in custom filters is visible only if 
"Attachment" option is selected. 

Verification Steps: 

Case1:  

Export of Part/any Object by assigning "Export without Attachments" privilege to a User. 

1. Create a user and assign the export privilege called "Export without Attachments". User should 
not have any other specific "Export" privilege, except what is necessary for data export. 

2. Create any object, for example Part, and add attachments to it. 

3. Export this Part by selecting attachments with Customized/Saved filter. 

Expected Result: The Part objects should be exported without attachments data in exported file for 
aXML and PDX formats. 

Case2:  

Export of part/any Object by assigning "Export" privilege to a User. 
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1. Create a user and assign the export privilege called "Export". User should not have any other 
specific "Export" privilege, except what is necessary for data export. 

2. Create any object, for example Part, and add attachments to it. 

3. Export this Part by selecting attachments with Customized/Saved filter. 

Expected Result: The Part objects should be exported with attachments data in exported file for 
aXML and PDX formats. 

7501269 

2-3280098; 2-5833965; 7065424.993 

SDK 

Issue: Can't get Agile session through Agile Web Server (cluster) 

Root Cause: SDK caches the connection server details and hence it causes issues if the server in the 
cluster goes down. 

Resolution: Added new APIs in AgileSessionFactory to refresh the connection which doesn't take 
from the cache but does try to load server properties again and hence get the details of the running 
server. 

Verification Steps: 

1. Create session using old APIs on Cluster setup by giving proxy URL. 
2. Set a break point after creating session. 
3. From the debug variable session.m_serverURL, find the server on which session is created. 
4. Bring down the server detected in previous step. 
5. Create session using AgileSessionFactory.refreshInstance (String URL) by giving 
proxy URL. 
6. Session should be created and debug variable session.m_serverURL should show the server 
details that are up and running. 
Execute above steps for all the 3 new refresh session APIs listed below:  
AgileSessionFactory.refreshInstance (String URL) 
AgileSessionFactory.refreshInstanceEx (Map params) 
AgileSessionFactory.refreshSessionEx (Map params) 

7864533 

7282445.994 

SDK 

Issue: Performance penalty for clearing out redline BOM table 

Root Cause: SDK invokes remove row multiple times for the entire table. So it invalidates the table 
multiple times causing very slow performance 

Resolution: SDK to invoke the batch remove API in the Server 

Verification Steps:  
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1. Create Item with BOM of 150 parts. 
2. Release this Item. 
3. Create a Change for the released Item. 
4. Clear Redline BOM table using ITable.clear(). 
5. All the Redline BOM rows are cleared in seconds. 
 

9211896 

3-1201263091 

Import-Export 

Issue: Agile Export does not have a way to prevent large BOM export that causes "out-of-memory" 
error 

Root Cause: With large exports, it is possible to cause out of memory conditions.  This enhancement 
is a means to try to prevent the out of memory issue by creating a threshold to limit large exports on 
the system. 

Resolution: A new limit has been added to Administrator properties (Java Client) that gives the 
maximum number of objects allowed in an export. When an export is invoked, the requested objects 
and the filters used are examined, and a close estimate of the number of objects that need to be 
extracted is calculated. This is compared to the limit defined in the Admin Preferences. If the limit is 
exceeded, then the export will be terminated with an error message, indicating the number of 
objects being exported as well as the specified limit. Note that this limitation is not enforced for 
ACS, but is enforced for other avenues for which export is executed. 

Verification Steps:  

Case1: 
In Java Client > Admin > Preferences, set the value for "Maximum Number of Objects to Export" to 
5. 

1. Create a part P1 and add four BOM objects to it. 

2. Export part P1. 

Expected Result: Part P1 should be exported and BOM data should match UI. 

 
Case2: 

1. Now add another BOM object to part P1. 

2. Try to export P1. 

Expected Result: While exporting P1, system should display an error message "Maximum number 
of objects for Export exceeded. Limit: 5, Estimated number of objects: 6." 

9849184 

Web Service 

Issue: Most query Web services fail for hard coded list-based criteria value. 
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Verification Steps:  

1. Create Query: 
<queryIdentifier> 
<name>Personal 
Searches/AdvancedSearch6770892</name> 
</queryIdentifier> 
<searchClassIdentifier>6141</searchClassIdentifier> 
<criteria>[1049] in ('Other')</criteria> 

The  query object gets created on the server side as can be seen in the UI. But  the Web 
service does not send a properly formed XML response. 

2.  Load Query: 
<queryIdentifier> 
<name>Personal 
Searches/AdvancedSearch6770892</name> 
</queryIdentifier> 

The Web service does not send a properly formed XML response. 

3. Update Query by changing the value of the criteria: 
<newQueryParams> 
<queryIdentifier> 
<name>AdvancedSearchNEW108721</name> 
</queryIdentifier> 
<searchClassIdentifier>6141</searchClassIdentifier> 
<criteria>[1049] contains ('Other')</criteria> 

The Web service does not send a properly formed XML response. 

Common Services 
7072934 

18947196.6; 18966276.6; 18995218.6; 2-2992520; 2-3431739; 2-3597272; 2-4333676; 2-4811388; 7322116.993; 
7335862.993 

Searches 

Issue: Inactive list items show up on Advanced Search 

Root Cause: The search doesn't use the Inactive List setting in user preferences to filter out query 
result data. 

Resolution: According to the user preference Inactive List setting to filter query results. 

Verification Steps:  

1. Log in to the system with admin/agile 

2. Create a user, test01, go to Preferences table: include Inactive List Values: No Privilege. 

3. Log in to Java Client with admin/agile. 

4. Go to Admin > Privilege > Modify/Read. 

5. Click show all > Modify/Read user > Click AppliedTo > move users.preferences.Include 
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Inactive List Values to Selected field. 

6. Click Save. 

7. Log in with test01/agile, check the Preferences table: Include Inactive List Values = Yes. 

8. Go to Admin > Classes > Parts > UI > Cover Page. 

9. Find Part category list. 

10. Click View details button. 

11. Go to list > Disable software value. 

12. Save it. 

13. Go to the Advance Search table. 

14. Search for Items > Parts > object search. 

15. Part category in Software (inactive) value. 

Expected results: The Software (inactive) value can be displayed in the Part category. 

7497232 

7203691.992 

Searches 

Issue: Agile loads inactive values in Advance Search. 

Root Cause: The search doesn't use the Inactive List setting in user preference to filter out query 
result data. 

Resolution: According to the user preference Inactive List setting to filter query results. 

Verification Steps:  

1. Log in to the system with admin/agile 
2. Create a user, test01, go to Preferences table: include Inactive List Values: No Privilege. 
3. Log in to Java Client with admin/agile. 
4. Go to Admin > Privilege > Modify/Read. 
5. Click show all > Modify/Read user > Click AppliedTo > move users.preferences.Include 
Inactive List Values to Selected field. 
6. Click Save. 
7. Log in with test01/agile, check the Preferences table: Include Inactive List Values = Yes. 
8. Go to Admin > Classes > Parts > UI > PageTwo list01 
9. Enable PageTwo list01, find Part.PageTwo.list01 
10. Create list: single list, not cascading list. 
11. Value:1, 2, 3, 4, 5, 6, 7 (lnactive). 
12. Assign the list to Part.PageTwo.list01. 
13. Save it. 
14. Go the Advance Search table in Web Client as test01/agile. 
15. Item search: Part.PageTwo.list01 is displayed. 
16. Check the list value, 7 inactive list is displayed in PageTwo list01 list. 
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9409536   

Searches 

Issue: Discussion.Organization Palette on Search page is showing no-values text message. 

Root Cause: The Organization attributes have wrong metadata about Search operation type. 

Verification Steps: 

1. Login to Web Client. 

2. Go to Advanced Search and select either Sourcing Projects, RFQ, or RFQ Response base class 
and class options from respective dropdown lists. 

3. Select the Organization attribute from Attributes dropdown list and select In or Not In operator. 

4. Set focus on input value field and launch the palette. 

Result: The launch palette shows the list values properly. 

9731391 

SR 3-1749598861 

Searches 

Issue: Error in basic search on File Folders with "Include Attachments Text" checkbox. 

Verification Steps:  

1. Log in to the system with admin/agile. 

2. Create File Folder with files: Test. 

3. Log in to Java Client and make sure Full Text Search with synchronized status. 

4. Log back in to Web Client. 

5. Go to the basic search table. 

6. Select File Folder > File Folder 

7. Name/Number/Description contains Phase: Test. 
 

Product Collaboration 
7060817 

18936676.6; 2-4304634 

Changes 

Issue: Enhancements: (1.) Make Deviation icon visible on BOM at child line.  (2.) Show Deviation 
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icon in parent BOM's Pending Changes column when there is a Released Deviation against an 
Item.  

Root Cause: Enhancements. 

Resolution: Check the Item object whether it has Pending or Released Stop Ship or Deviation object, 
then do some setting for the Change Image field. 

Verification Steps: 

1. Log in to Web Client. 

2. Create a Part named P001. 

3. Create a Stop Ship named S001 against this P001, change status to Released. 

4. Go to Affected Items tab.  

Expected and actual results: Red square Icon display on Pending Changes (Image)  column. 

5. Open P001, go to Changes tab. 

Expected and actual results: Red square Icon display. 

6. Create another Part named P002. 

7. Create a Deviation named D001 against this P002, change status to Released. 

8. Open P002, go to Changes tab. 

Expected and actual results: Red square Icon display. 

7530425 

2-2654425; 7163623.994 

Changes 

Issue: Add to LifeCycle Phase on an Item's Change tab > Pending Changes table. 

Root Cause: This is a new feature. 

Resolution: Add metadata in DB to make sure showing lifecycle phase field on item changes tab 
pending change table 

Verification Steps:  

1. Log in to Java Client. 

2. Go to Admin > Settings, and open Part class > Changes tab  

3. Go to Attributes: Pending Change History tab. 

4. Enable the attributes "Lifecycle Phase" and other newly added attributes.  

5. Log in to Web Client. 

6. Create a part named P001. 
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7. Create an ECO named C001 against P001.  

8. Edit Lifecycle Phase to "Production".  

9. Open P001 and go to Changes tab. 

Expected and actual results: On Pending Changes table, Production value display on Lifecycle 
Phase column, meanwhile, other newly added attributes also display on that table. 
 

9027251 

2-5834311; 3-1563076641; 7821553.992 

Workflow 

Issue: Request to have configuration to enable or disable approval/reject password 

Root Cause: This is a new feature. 

Resolution: Add code to permit user to approve or reject without filling in password. 

Verification Steps:  

1. Log in to Java Client. 

2. Open Default Change Orders workflow. 

Expected and actual results: Go to CCB and Release status, for each status, adding the new 
configuration  "Password Required", default value is "Yes", other options are: Approve Only, Reject 
Only, and No. 

3. Save As to a new workflow "wf01". 

4. Add two new CCB statuses: CCB1 and CCB2. 

Expected and actual results: For the newly added statuses, adding the new configuration 
"Password Required" and default value is "Yes". 

5. Add two new Released statuses: Release1 and Release2. 

Expected and actual results: For the newly added statuses, adding the new configuration 
"Password Required" and default value is "Yes". 

6. At CCB1, set Password Required to "Approve Only". 

7. At CCB2. set Password Required to "Reject Only". 

8. At Release1 status, set "Password Required" to "No". 

9. Create corresponding Change Status privilege and assign to Administrator user. 

10. Log in to Web Client. 

11. Create an ECO C001, assign it to workflow "wf". 

12. Move the change to CCB1 status, add user1 as approver. 
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13. Log in as user1 and approve the change. 

Expected and actual results: user need to type in password to approve the change. 

14. user1 rejects the change. 

Expected and actual results: user can reject the change without typing the password. 

15. Move the change to CCB2 status, add user2 as approver. 

16. Log in to Web Client. 

17. Approve the change.  

Expected and actual results: user2 can approve the change without typing the password. 

18. Reject the change. 

Expected and actual results: user2 needs to type in password to reject the change. 

19. Route the change to Release1 status, add user3 as approver and user4 as observer.  

Expected and actual results: Log in to Web Client as user3. 
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Chapter 3 

Known Issues 
This chapter includes the following: 

 Known Issue Disclaimer ...................................................................................................................................... 23 
 Install and Upgrade .............................................................................................................................................. 23 
 Agile Configuration Propagation .......................................................................................................................... 25 
 Agile Technology Platform ................................................................................................................................... 27 
 Integration ............................................................................................................................................................ 28 
 Common Services ............................................................................................................................................... 32 
 Engineering Collaboration ................................................................................................................................... 34 
 Product Collaboration .......................................................................................................................................... 35 
 Variant Management ........................................................................................................................................... 36 
 Product Cost Management .................................................................................................................................. 47 
 Product Portfolio Management ............................................................................................................................ 51 
 Product Governance and Compliance ................................................................................................................. 55 
 Recipe & Material Workspace ............................................................................................................................. 55 

This chapter contains a list of known issues for this release. These were deferred from this release, 
but may be fixed in a future release. Numbers in this section are for Oracle Agile internal use only. 

Known Issue Disclaimer 
This list of Known Issues consists of those found at the time of the initial release. The product may 
have additional issues found after the initial release and therefore this list is subject to change and 
is not always comprehensive. Oracle support will continue to track known issues of this product 
release found on My Oracle Support. Please check for updates at https://support.oracle.com. 

For each known issue: 

 On the first line, the number is the internal Defect number. 
 

Install and Upgrade 
9168396 

Main Installer 

Issue: Agile 931 Installer is displaying the wrong HTTP listen port in Recipe & Material Workspace 

Steps to Reproduce:  

1. Install OAS10134 application server and note the current listen port, for example, "80". 

2. Stop the OAS server.  

3. Modify the listen port (e.g., change "80" to "7777") in httpd.conf file of 
<OAS_HOME>\Apache\Apache. 

https://support.oracle.com/
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4. Restart the OAS server. 

5. Launch the 931 Installer and go to "AgilePharma-OASConfiguration" screen and check the port 
number. It is showing the old listen port ("80"), but it should display the new listen port ("7777"). 

Workaround: Update the file OAS_HOME/Apache/Apache/conf/ohstarget.xml to reflect the 
new HTTP listen port. 

9298696 

Agile (Main) Installer and Recipe & Material Workspace 

Issue: Recipe & Material Workspace cannot be installed in an Agile cluster. 

9575289 

Database Install 

Issue: Reorganization of Agile DB using Data Pump is not working on 11gR2. 

Steps to Reproduce:  

1. Install 11gR2 binaries. 

2. Create database instance. 

3. Perform reorganization using Data pump. While running agile9impdp.sh file errors are 
reported in the log files. 

Workaround: Use Import/Export or use an older database server version (for example,10gR2 or 
11gR1). 

9891903 

Main Installer 

Issue: Unable to start second managed server service in WebLogic cluster if more than one 
managed server is installed in the same machine. 

Steps to Reproduce:  

1. Install PLM cluster in WebLogic (multiple managed servers in one machine) as service mode. 

2. Configure all the managed servers and JMS servers settings in Admin console. 

3. Start one managed server from services per, say, AgilePLMManaged1. 

4. Try to start another managed server from services and check for the error (service status). 

Workaround: Start Agile managed server using startServerAgileManaged2.cmd (do not use 
AgilePLMManaged2 service). 

9902141 

Main Installer 
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Issue: Unable to start Agile application in Service Mode in Windows 2003 64-bit operating system. 

Steps to Reproduce:  

1. Install PLM application on WebLogic server in Service Mode in Windows 64-bit operating system. 

2. Try to start the service "AgilePLM" from services. 

Workaround: Start using the StartAgile.cmd file. 
 

Agile Configuration Propagation 
8558774 

3-1364424811 

Agile Configuration Propagation 

Issue: PPM UI configuration is not propagating group/table and Action Groups attributes 

Steps to Reproduce:  

1. Create Attribute Group/Table and Action Groups in PPM UI Configuration DATA. 

2. Export the following configuration file: 
<copy> 
<ppm_ui_configuration_data/> 
</copy> 

3. Import the same on the target instance. 

4. Attribute groups are not being propagated to the target and ACP is throwing an error in 
import.err. 

9246430 (9955696) 

Agile Configuration Propagation 

Issue: Propagation of list type as Dynamic List throws error. 

Steps to Reproduce:  

1. Create a list with list type of Dynamic List and assign criteria. 

2. Export the following configuration snippet: 

      <copy> 

   <list/> 

   </copy> 

3.  Propagation of the "Dynamic List" list type should be exempted, that is, ACP does not support 
propagation of Dynamic/Criteria-based lists. 
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9307243 

Agile Configuration Propagation 

Issue: Return unexpected error in Deep Compare 

Problem: Failed to generate deep compare reports and throws up with (a similar kind of error – too 
many open files) java.io.FileNotFoundException: 
/apps/agile/agile9301/acp/acpwork9301/20100119_1/ReportTemplates.xsl (too 
many open files) on Unix platforms. 

Reason: Comparing many objects can initiate too many processes on the current shell, which can 
result in not running Deep Compare. 

Workaround: Use the ulimit command to set up a higher limit of the shell. You can revert to 
previous limit after executing Deep Compare. ulimit provides control of resources available to 
the shell, and of processes started by it, for systems that allow such control. Please refer to the 
manual for ulimit. 

Command to execute on the shell (before running Deep Compare): 
#su root 
#ulimit -n 1000000 

9644171 

Agile Configuration Propagation 

Issue: History details are blank for any list in WebLogic cluster 

Steps to Reproduce: 

1. Log in to Java Client of WebLogic cluster. 

2. Go to Admin > Data Settings > Lists. 

3. Create a new list, e.g. List101. 

4. Add some data into List101. 

5. Go to History tab of that list. 

6. The History details are blank. 

9884731 (10052658) 

3-1841312617 

Agile Configuration Propagation 

Issue: Unable to resolve languages. 

Steps to Reproduce: For customers who use multiple languages in their system, they must manually 
enable the languages in target instances, then re-start the server to activate these enabled 
languages in order for ACP to work properly. 
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Workaround: The language settings in Server Settings > Preferences (<server_preference/> in 
config.xml) should be propagated before Lists. 
 

Agile Technology Platform 
9217623 

Export 

Issue: Button 3 is not enabled ("clickable") on Export dialog. 

Steps to Reproduce: 

1. From Web Client select any part and click Actions menu > Export. 

2. Export dialog will be launched with selected part. 

3. In Export dialog, click button "2" (on right top of the dialog). 

4. Now select Create Custom Filter radio button. 

5. Try to click on button "3" to move to next wizard. 

Button "3" is not clickable. All other buttons are clickable, and user can move back and forth via 
buttons, except button "3". 

9825857 

Agile Integration: Export 

Issue: When exporting a Part that is in the Instances tab of a model, the base model field does not 
appear. 

Steps to Reproduce: 

1. Create a Model, e.g. M1. 

2. Add a Part P1 in the Instances tab of Model M1. 

3. In the title block of P1, a base model field will have value as M1. 

4. Export the P1 in excel. 

5. The base model value does not appear in the UI as some other values appear. 

Note: Base Model value/attribute, itself is not seen in exported AXML file. 

9851675 

Agile Integration: Export 

Issue: System default filters are not displayed properly by adding the 
"export.useMinimalSystemFilter" in agile.properties. 
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Steps to Reproduce: 

1. Set the "export.useMinimalSystemFilter=true" in agile.properties. 

2. Create a Part. 

3. Try to export the Part. 

4. In the export dialog select System Default Filter and click on the Details button. 

Note: It is showing all the tabs, but instead should show: 

    Item Filters: Title Block, P2, P3, BOM, Mfr Part, Attachments 

    BOM: tab only - implies BOM level 0 

    AML: tab  

    Attachments: tab  

    The same case applies to Changes, Manufacturers, Manufacturer Parts. 

9864283 

Agile Technology Platform – Security 

Issue: Account lockout does not work on AIX+ WebLogic server environment. 

Steps to Reproduce: 

1. Log in to Java Client as administrator. 

2. Open Account Policy. 

3. Set Account Lockout = Enabled, Login Attempts = 2. 

4. Create a user, e.g. tao/agile. 

5. Attempt to log in to Java Client as tao/a, tao/b, tao/c. It shows error message "User:tao failed to 
be authenticated". 

6. Log in to Java Client as administrator. 

7. Open user tao, unlock it, error message "Cannot reset this user account. Account Lockout may 
not be enabled or the user" appears. 

Note:  It should show "Invalid password" in step 5. It should not pop up any error message in step 7. 
 

Integration 
9298808 

SDK: Document Publishing (Core Functionality: Folders, File and Attachments) 

Issue: Thumbnail icon is not getting displayed in preview and report generation. 
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Steps to Reproduce: 

Prerequisites: Set up Events (Event Handlers and Event Subscribers). 

1. Log in to Web Client. 

2. Trigger Template management structure creation Process Extension (PX). 

3. Trigger Schema Generation PX. 

4. Trigger Data Generation PX. 

5. Add a .rtf file to a Part/Document. 

6. Navigate to Agile PLM word plugin and insert fields into the .rtf file. 

7. Try preview the file after inserting the fields. 

8. In Web Client, navigate back to the respective part/document and create a change against the 
object. 

9. Release the change object. 

10. Navigate to the respective object where report file has been generated. 

11. Open the report to view the file. 

Actual Result: Thumbnail is not getting displayed in report generation. Also thumbnail is not 
displayed in preview view from word plugin. 

Expected Result: Thumbnail should get displayed in the report generation file. 

Workaround: BI Publisher supports several methods for including images in your published 
document: 

1. Direct Insertion: Insert the JPG, GIF, or PNG image directly into your template. 

2. URL Reference: (a.) Insert a placeholder image in your template.  

(b.) In Microsoft Word's Format Picture dialog, select the Web tab, and enter the following 
syntax into the Alternative text region to reference the image:  

URL:{'http://image location'} 
For example: 

url:{'http://www.oracle.com/images/ora_log.gif'} 

3. Element Reference from XML File: (a.) Insert a dummy image in your template.  

(b.) In Microsoft Word's Format Picture dialog, select the Web tab, and enter the following 
syntax in the Alternative text region to reference the image: 

url:{IMAGE_LOCATION} 
where IMAGE_LOCATION is an element from your XML file that holds the full URL to the image. 

4. Build a URL based on multiple elements at runtime: Use the concat function to build the URL 
string. For example: 

url:{concat(SERVER,'/',IMAGE_DIR,'/',IMAGE_FILE)} 
where SERVER, IMAGE_DIR, and IMAGE_FILE are element names from your XML file that 
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hold the values to construct the URL. 

This method can also be used with the OA_MEDIA reference as follows: 
url:{concat('${OA_MEDIA}','/',IMAGE_FILE)} 

9327364 

SDK: Document Publishing (Core Functionality: Folders, File and Attachments) 

Issue: Agile PLM Add-in's still displays from Word on removal of wWrd plugin. 

Steps to Reproduce: 

Prerequisites: Navigate to Control Panel and remove the Agile Word plugin completely. 

1. Open MS Word. 

2. Navigate to Add-ins menu 

Actual Result: Agile PLM menu still displays on removal of Agile Word plugin. 

Expected Result: Agile PLM menu should not be displayed once Agile Word plugin is removed. 

Workaround: To completely remove Agile PLM Add-in's, the user has to delete files from the 
following location:  

C:\Documents and Settings\<userName>\Application 
Data\Microsoft\Templates 

9535092 

SDK: Document Publishing (Core Functionality: Folders, File and Attachments) 

Issue: HTML Report is not displayed properly for Document generation Web Services PX. 

Steps to Reproduce: 

Prerequisites: Setup an Event PX for DocumentGenerationWSPX. 

1. Log in to Web Client. 

2. Trigger Template Management Structure Creation PX. 

3. Trigger Schema Generation PX. 

4. Navigate to titleblock page and set the document type to HTML. 

5. Trigger Data Generation PX. 

6. Attach the RTF file to an item object. 

7. Create a change and release the change object. 

8. HTML report got generated and attached to the attachment type of respective object. 

9. Get the html report and try opening it. 

Actual Behaviour: Display of HTML report was not proper (distorted) for Document Generation 
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WSPX, whereas display of html report was proper when triggered through Document Generation 
JAVA PX. 

9684369 

SDK: Document Publishing (Core Functionality: Folders, File and Attachments) 

Issue: Error message displayed for data generation on setting filter as "tab and files". 

Steps to Reproduce: 

Prerequisites: a) In Java Client > Admin > System Settings > Agile Content Service > Filters. 

b) Create a new filter with Attachment options as "Tab and Files". 

Steps: 1. Log in to Web Client. 

2. From Tools menu trigger Template Mgt Structure creation PX. 

3. Trigger schema generation PX from Actions menu. 

4. Create a part/document and set the PageTwo fields and trigger data generation PX. 

5. Open Word document to create a template and assign tables into it. 

6. Log in to AgilePLM and load the schema. 

7. Now load the data. 

Result: Displays an error message and not able to proceed further. 
 

9967769 

FileLoad 

Issue: FileLoad fails when Japanese dash (zenkaku, or full-width hyphen) is used in Manufacturer 
Part Number and user's encode type is set to "Japanese (Shift-JIS)". 

Steps to Reproduce: 

1. Log in to Java Client. 

2. Make sure that user's Preference encode-type is set to "Japanese (Shift-JIS)". 

3. Create below Manufacturer and Manufacturer Part. Make sure to include Japanese full-width 
(zenkaku) hyphen in Manufacturer Part name: 

  Manufacturer: (for example) MFG1 

  Manufacturer Part: (for example) 123+456—00N602 

4. Create index file for Fileload. Include line like: 

  MFR_PART,"MFG1","123+456—00N6022",D:\temp\test1.txt,FILE,test 

5. Run Fileload. Fileload will fail with below error: 

  Row 
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  #1:MFR_PART,"MFG1","123+456¿00N6022",D:\temp\test1.txt,FILE,test<CR> 
<Unknown Number: Object does not exist.> 
 

Common Services 
9299251 

Folders, Files and Attachments 

Issue: Include characters set to "All" for Number attribute of Document template subclass. 

Steps to Reproduce:  

1. Log in to Java Client > Admin > Classes > Items > Document template subclass. 

2. Navigate to Title Block and locate for Number attribute. 

3. Double-click on the Number attribute and set Include characters to "All". 

Result : Template Mgt Structure property file should be in conformance with Java Client Admin 
settings. 

Workaround: Ensure the values set in Template Management Structure property file are in 
conformance with Java Client Admin settings. In 
TemplateManagementStructure.properties file 
TEMPLATE_SUBCLASS_API_NAME=DocumentTemplate, is created correctly only when the value 
is set properly in Java Client (above steps). 

9839049 

Searches 

Issue: Searches are not working if the time part is part of search criteria. 

Steps to Reproduce: 

1. Create two Change Orders. 

2. Go to Advanced Search and try to search based on "Date Originated" by giving date and time of 
first change order. Note that both changes are displayed in results. Also, if this search is saved as a 
Personal Search, and you look at the criteria, note the time part is missing. If search is reconfigured 
on Dashboard Optional tab, it loses the time part. 

Workaround: Run query from personal search, open the criteria, change it manually, and run it again. 
There is no loss of functionality. 

9859619  

Folders, Files, and Attachments 

Issue: Does not get replaced with special character files on Design & File folder object. 

Steps to Reproduce: 

1. Create a design object. 
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2. Add a special character file like !@#$%^.jpg. 

3. Check-in the object with version 1. 

4. Again checkout the object with pending version (2). 

5. Replace file with any other jpg file. 

Note: The file does not get attached and get the message "the checked-in file must have the same 
file extension as the checked-out file. please select again or cancel." 

Workaround:  Change the file name and replace. 

9887022  

Folders, Files, and Attachments 

Issue: File associated with file folder object is not getting copied to revision. 

Steps to Reproduce: 

Pre-Condition: Set the SmartRule, Copy Files to Rev - Designs = "Reference with Warning" and 
Copy Files to Rev - File Folder = "Copy". 

1. Log in to Web Client/Java Client. 

2. Create a Part P001 and add 2 files to it, one associated with File Folder (F001) object and other 
with Design (D001) object. 

3. Now create a change against the Part P001. 

4. While creating a change, you will get a warning message.  

5. Select the radio button "Proceed without Attachments" and click on Finish Button. 

6. Then verify for the files in P001's Pending revision. 

9887038  

Folders, Files, and Attachments 

Issue: Not able to create a change in Java Client (JC) when smart rule "copy files to rev" is set to 
warning. 

Steps to Reproduce: 

Case 1: 

Pre-Condition: Set the SmartRule "Copy files to Rev - Design = Reference with Warning" and "Copy 
file to rev - Design = Disallow". 

1. Log into Java Client. 

2. Create a Part and add 2 files to it - one associated with file folder object and other associated 
with Design object. 

3. Create a change against the part. 

mailto:!@#$%^.jpg
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4. Warnings and Errors Dialog will appear. 

5. Click on the OK button. Don't select any checkboxes in the dialog. 

Actual Result: ECO is not getting created. 

Expected Result: ECO should be created and files should not be copied to new revision. 

Case 2: 

Pre-Condition: Set the SmartRule "Copy files to Rev - Design = Reference with Warning" and "Copy 
file to rev - Design = Copy with Warning". 

1. Log into Java Client. 

2. Create a Part and add 2 files to it - one associated with file folder object and other associated 
with Design object. 

3. Now Create a change against the part. 

4. Warnings and Errors Dialog will appear. 

5. Select any ONE check box in that Dialog, then click on OK Button. 

Actual Result: ECO is not getting created. 

Expected Result: ECO should be created and only the Smart Rule that was selected should get 
applied. 

10023920 

Folders, Files, and Attachments 

Issue: Need to enter login credential to view file every time on WebLogic server in Java Client in IE7.  

Steps to Reproduce:  

1. Log in to Java Client and create a part. 

2. Add a file and view. 

The Login Credential window is displayed. 

Expected Result: Should not display the page, should directly view the file in Viewer. 

Workaround: Enter the login credential to view the file in IE7 or upgrade the browser to IE8. 
 

Engineering Collaboration 
9277610 

EC Services 

Issue: Get Design where attached should retrieve Design linked to Part for All-All combination. 

Steps to Reproduce:  
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1. Let there be Structure for Design and Part as below: 

DESIGN000025 (Version 1) > Where Used > Attachments: P00009 Rev (AB), P00010 Rev 
Introductory, P00011 Rev Introductory, P00011 Rev (XXX) 

DESIGN000025 (Version 2) > Where Used > Attachments: P00009 Rev (AA), P00009 Rev 
(AB), P00010 Rev (ABC), P00011 Rev Introductory 

DESIGN000025 (Version 3) > Where Used > Attachments: P00009 Rev Introductory, P00011 
Rev Introductory 

2. When we pass Target–Design–Version value ALL and Where Used–Item–Revision value ALL, 
system retrieves 7 Agile objects. It is not clear from this result which Part revision is linked with 
which Design Version. 
 

Product Collaboration 
9378738 

Folder, Files and Attachments 

Issue: Get Structure issue with Advanced Download. 

Steps to Reproduce: 

1. Create a valid Design Structure. 

2. Set the Download Structure setting in preferences to Prompt. 

3. Now get the file in the parent object of the Design. Will prompt to download. 

4. Select Advanced and click for Download Structure. 

5. As per the structure download, it should download the ZIP files: however, individual files are 
downloaded. 

9947092 

Product Collaboration – Instance Manager 

Issue: Select checkbox and the quantity column does not align correctly when you switch to 
standard BOM view 

Steps to Reproduce: 

(Prerequisite)  

1. In Java Client > Admin > Server Settings > Preferences > Thumbnail Support: set to Enabled. 

2. For User 1, User Preferences > Display Preferences, set Thumbnails to On; set Table Display 
Mode to With Thumbnail; set Search Display Mode to With Thumbnail. 

3.  In Instance Manager, for User1, set up a personalized view "User1View" and set it as default. 
The Format of the view has only the required attributes as follows: Thumbnail, Attachment (Image), 
Item Number, Find Number, Optional, Mut Excl, Min Qty, Max Qty (lock at this attribute), Qty, Ref 
Des. 
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(Steps)  

1. Login as User1. 

2. Create new Model Option BOM: 

     --M1 

         --- M2 

   Note that the BOM should show Thumbnail view. 

3. Add new Parts P1 and P2 to Instances tab. 

4. Select the Parts and launch configurator. Instance Manager opens up with Thumbnail view which 
is expected. 

5. Close Instance Manager. 

6. Go to BOM tab. 

7. From More action list, select Standard View. 

8. Go to Instances tab. 

9. Select the Parts and launch configurator.  

10. Check the Select checkbox and Quantity alignment under each instance. 

Note: Select and Quantity columns do not fall under the instance. 

Workaround: There are several possible workarounds: 

1. Do not lock any column. 

2. Move Thumbnail to the last possible column position. 

3. Move Thumbnail to any position of the scrollable part except the first position. 
 

Variant Management 
9135052  

Product Collaboration: Model/Option BOM 

Issue: Object Type list to filter out non-model object types for Variant Management events 

Steps to Reproduce:  

1.  In Admin, create Event selecting any of the VM Event Types. 

2.  Check Object Type list. 

Note: Object types like Part, Document, and Option Classes are included even though only Items 
base class, Parts class, and Model subclass should be included. 
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Workaround: In 931 PLM Administrator Guide > Event Management chapter, explanatory note has 
been added to "Attributes of Event Masks": Do not change the Object Type for VM.  When creating 
a new event for VM, the entry for Object Type has to remain with its default entry (= Items). 

9271453  

Product Collaboration: Model/Option BOM 

Issue: Event related fields that are to be hard-coded or read only. 

Workaround: In 931 PLM Administrator Guide > Event Management chapter, explanatory note has 
been added to "Attributes of Event Masks" and "Attributes of Event Subscriber Masks." 

9437157  

Product Collaboration: Model/Option BOM 

Issue: Variant Management events do not work if trigger type set to "post". 

Steps to Reproduce:  

Administrator Configuration: 

1. Configure the system with default scripts: 
<Event/SPX>- Derive Variant Model Option 
BOM:DeriveVariantModelOptionBOM.groovy  

Make sure Create Variant Instance event is disabled. 

Use system default for Create Instance. 

2. Set Trigger Type to "Pre" for the event subscriber. 

3. Enable event triggering on the system. 

From Web Client: 

1. Login to Web Client. 

2. Create a model M1. 

3. Add the following structure to M1 BOM table: 

Qty......MinQty...MaxQty...Optional 

-OC1           2       3       10 

|___P1        2       2       10 

|___P2        1       1        5 

-P3              1 

4. Add a standard part P00001 to M1 Instances tab. 

5. Select P00001 and launch configurator (IM). 

6. On IM, select P1 and click "Create Instance"; ==> Instance BOM successfully created. 
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7. In Java Client, change the Trigger Type to "Post" for Derive Variant Model Option BOM event 
subscriber. 

8. In Web Client, add a standard part P00002 to M1 Instances tab. 

9. Select P00002 and launch configurator (IM). 

10. On IM, select P1 and click "Create Instance". 

Bug: 1. Post view shows empty BOM. 

2. Click "Back" button to go back to IM, selection fields and buttons are not disabled. ==> Bug - 
System returns "Model-Option BOM is valid". 

9460444  

Product Collaboration: Instance Manager 

Issue: Default scripts: Able to create instance even if instance already has BOM structure. 

Steps to Reproduce:  

Admin Configuration: 

1. Configure the system with default scripts: 

-<Event/SPX> - Update Variant Configuration: UpdateVariantConfiguration.groovy / 
UpdateVariantConfigurationReadOnlySetting.groovy 

- Create Variant Instance: CreateVariantInstance.groovy 

- Derive Variant Model Option BOM: DeriveVariantModelOptionBOM.groovy 

- Validate Variant Instance Selections: ValidateVariantInstanceSelections.groovy 

- Validate Variant Configuration: ValidateVariantConfiguration.groovy 

- Validate Variant Model Option BOM: ValidateVariantModelOptionBOM.groovy 

2. Enable event triggering on the system; IE8 

Procedure: 

1. Log in to Web Client; 

2. Create a Model M1; 

3. Create the following structure on M1 BOM table: 

..........   Qty   Min   Max 

- OC1      2     2     10 

|___ P1    2     2     10 

|___ P2    2     2     10 

- P3       2 

4. Add two new parts P00001 and P00002 to M1 Instances table. 



 Chapter 3: Known Issues 
 

 

v9.3.1 39  

  

5. Select P00001 and P00002 then launch configurator (IM). 

6. On IM, select P1 for P00001 and P2 for P00002 then Save As Draft. 

7. Retrieve P00002, add a new standard part Part1 to its BOM table. 

8. On IM, set radio button to P00002 and click "Create Instance". 

Bug: Able to create instance for P00002 with following BOM structure: 

-P2   4 

-P3   2 

-Part1 1 

Expected: System should return pop-up error dialog "You cannot derive the Instance BOM, 
because the Instance already has a structure!" when trying to create instance. 

Note: Defect not reproducible if event is disabled on system. 

9635804  

Product Collaboration: Model/Option BOM 

Issue: Event not triggered on custom model subclass if object type is set to new subclass. 

Steps to Reproduce:  

Administration Configuration and Data Preparation: 

1. Create a new subclass: 

- Class ==> Parts 

- Part Subtype ==> Model 

- Name ==> Model2 

2. Create a Validate Variant Model Option BOM event, set Object Type to "Model2". 

3. Create a SPX handler with default VVMOB script 
ValidateVariantModelOptionBOM.groovy. 

4. Create a subscriber binding the event with SPX. 

5. Enable event triggering on the system. 

Procedure: 

1. Login to Web Client. 

2. Create a Model2 object M2; 

3. Add a standard part P1 to M2 BOM table. 

4. Click More | Check Model-Option BOM. 
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5. Check Event Handler Monitor in Java Client. 

Bug: Validate Variant Model Option BOM event is not triggered. 

Expected: Validate Variant Model Option BOM event should be triggered on M2 since the event 
Object Type is set to "Model2". 

Notes:  1. VM events will be triggered on Model2 object if event Object Type = Items, Parts or 
Model. 

2. VM events will not be triggered on Model2 object if event Object Type = Model2. 
 

9672815  

Product Collaboration: Model/Option BOM 

Issue: User does not have read privilege on instance.item name once configurator has been 
launched. 

Steps to Reproduce:  

Prerequisite: 

User1 is assigned all privileges on Model except that he does not have Read privilege on 
Instances.Item Name 

1.  Have User1 retrieve a Model BOM with some derived instances in Instances tab and some 
instances that are non-derived. 

2.  Select all the instances and launch configurator. 

3.  Select only the derived instances. 

4.  Launch configurator. 

Bug: Configurator can be launched even though user cannot read any Instance number of the 
instances inside the Instance Manager. 

Expected: This should work similarly to the way instances that have not been derived work. A user 
without read privilege on Instances.Item Name should not be able to launch configurator. 

9745662  

Product Collaboration: Model/Option BOM 

Issue: Cannot import instances if there is a change against the parent model. 

Steps to Reproduce:  

1.  Create ModelA with a BOM Mod1. 

2.  Add to Instances tab Part1. 

3.  Launch configurator and select Mod1.  Save as Draft. 

4.  Create a pending Change against ModelA. 
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5.  From Introductory, export Instances tab content to axml file (select Title Block and Instances tab 
during Export). 

6.  Remove Part1 from ModelA Instances tab. 

7.  Do an Import, selecting the aXML file in step 5 and import to Instances tab. 

9754341  

Product Collaboration: Model/Option BOM 

Issue: Import to Instances table should support add/update instead of complete replace. 

Steps to Reproduce:  

1. Create a model M0. 

2. Add an optional part P1 to M0 BOM table. 

3. Add a part PART1 to M0 Instances table. 

4. Select PART1 and launch configurator (IM). 

5. In IM, select P1 and Save as Draft. 

6. Close IM. 

7. Export M0 to an aXML file. 

8. Extract agile.xml from aXML, change Instances table info of M0 from PART1 to PART1NEW 
and save the updated aXML. 

9. Add a new part PART2 to M0 Instances table; (Now M0 Instances table contains 2 parts: PART1 
& PART2.) 

10. Import the updated aXML, make sure the Multi Row Update Mode is set to Add/Update Only. 

11. Make sure no error occurs during import. 

12. Check M0 Instances tab. 

Bug: PART1 & PART2 are removed.  There is only one item PART1NEW on Instances tab. 

Expected: Imported item PART1NEW should be added to the Instances table so that it contains 3 
rows: PART1, PART2 and PART1NEW. 

9754617  

Product Collaboration: Model/Option BOM 

Issue: A rollback is not occurring when the import shows error 

Steps to Reproduce:  

Prerequisite: SmartRule DeleteInstanceWithDerivedBOM should be set to  "Warning". 

Scenario 1: 
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1.  Create ModelA with a BOM structure. 

2.  Add Part1 and Part2 to Instances tab. 

3.  Launch configurator on Part1 and Part2. 

4.  Configure both Part1 and Part2. Create Instance on Part1 (Part2 configuration is also implicitly 
saved). 

5.  Do any Export to aXML file.  Select to export Instances tab content. 

6.  Change Instance header name by changing the Item Number from Part1 to Part1_B, Part2 to 
Part2_B (can be done directly on the instance objects or from an XML file). 

7.  Do an Import, select to Import Instances tab content.  Import shows Batch exception. 

8.  Check Instances tab. 

Result: Part1_B is still in the Instances tab but Part2_B is removed. 

Expected: With exception, the replace should be rolled back.  Both Part1_B and Part2_B should still 
be in the Instances tab. 

Scenario 2: 

1.  Create ModelA with a BOM structure. 

2.  Add Part1 and Part2 to Instances tab. 

3.  Launch configurator on Part1 and Part2. 

4.  Configure both Part1 and Part2. Create Instance on Part1 (Part2 configuration is also implicitly 
saved). 

5.  Do any export to aXML file.  Select to export Instances tab content. 

6.  Remove both Part1 and Part2 from Instances tab. 

7.  Do an Import, select to Import Instances tab content. Import shows that Part1 cannot be 
imported because there is an assembly. 

8.  Check Instances tab. 

Result: Part2 is imported into the Instances tab. 

Expected: Because there is an error, the Import should be rolled back (generic behavior for Import). 
Thus Part2 should not be imported. 
 

9793589  

Product Collaboration: Model/Option BOM 

Issue: Title block.Base Model attribute is returning junk value instead of Model number from SDK. 

Steps to Reproduce:   

1. Create Model object. 
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2. Create Part and add it to Instances table of Model. 

3. Retrieve Title Block.Base Model attribute on Part from SDK. 

9816436  

Product Collaboration: Model/Option BOM 

Issue: Instance BOM created even on insufficient privilege when create instance 

Steps to Reproduce:  

1. Set up user1 with a role that has the following privileges: 

- Configure Instance 

- Discover Items 

- Modify Preliminary Items 

- Read Items 

This user does not have Save As privilege. Set up User Preference to allow Internal configurator to 
be launched. 

2.  Create ModelA with the following BOM: 

ModelA 

--Document1 (Optional) 

--Model1 (Non-optional) 

3.  Add a standard part Part1 to Instances tab. 

4.  Select Part1and launch configiurator. 

5.  Select Document1.  Model1 should be pre-selected. 

6.  Hit Create Instance.  System generates an error of "Insufficient Privilege". 

7.  Close the error and close the Instance Manager. 

8.  Check Instance status of Part1 in the Instances table and check BOM table of Part1. 

Bug: Part1 instance status shows "Has derived Instance BOM".  Part1 BOM table contains 
Document1. 

Expected: Since there is error on Create Instance, instance BOM should not be derived on Part1. 

9826005  

Product Collaboration: Model/Option BOM 

Issue: No history tracking on Instances tab operations. 

Steps to Reproduce:  

1.  Create a Model. 
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2.  Go to Instances tab. 

3.  Perform some operations on Instances tab, e.g. add a standard part, modify its attributes and 
remove it. 

4.  Go to History tab and check for history tracking of the operations performed in step 3. 

9846447  

Product Collaboration: Model/Option BOM 

Issue: Validate Variant configuration event is not triggered for item with a Configuration Graph (CG). 

Steps to Reproduce:  

Scenario 1: 

1. Enable default SPXs on the system. 

2. Create a model M1. 

3. Create the following structure on M1 BOM table: 

-OC1 

|__P1             Optional 

|__P2             Optional 

-P3 

4. Add standard parts PART1 and PART2 to M1 Instances table. 

5. Select PART1 & PART2 and launch configurator (IM). 

6. In IM, select PART1_P1 and then de-select PART1_P1. 

7. Click Save as Draft. 

In this case, although there's no selection for PART1, but the CG is generated and the status icon 
of PART1 on Instances table shows Has Configuration Draft. 

8. Select PART1 and launch configurator. 

Result:  Validate Variant Configuration event is triggered (This is as expected.) 

Scenario 2: 

1. Enable default SPXs on the system. 

2. Create a model M1. 

3. Create the following structure on M1 BOM table: 

-OC1 

|__P1             Optional 

|__P2             Optional 
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-P3 

4. Add standard parts PART1 and PART2 to M1 Instances table. 

5. Select PART1 & PART2 and launch configurator (IM). 

6. In IM, select PART1_P1. 

7. Click Save as Draft. 

8. While radio button is on PART1, click Copy Configuration (copy configuration from PART2 to 
PART1, press Finish on Warning dialog). 

9. Click Save as Draft. 

In this scenario, although there is no selection for PART1, the CG is generated and the status icon 
of PART1 on the Instances table shows "Has Configuration Draft". 

10. Select PART1 and launch configurator 

Bug: Validate Variant Configuration event is NOT triggered 

9890708  

Product Collaboration: Instance Manager 

Issue: Getting Instance BOM is in use error after launching configurator failed with PX 

Steps to Reproduce:  

1. Create an SPX handler that always throws an exception: 
void invokeScript(IBaseScriptObj obj) { 
throw new AgileDSLException("This script always 
throws AgileDSLException.") 
} 

2. Create a Validate Variant Instance Selections event. 

3. Create a subscriber binding the event with error SPX. 

4. Enable the event triggering on system. 

5. Login to Web Client with user1. 

6. Create a model M1. 

7. Add the following structure to M1 BOM table: 

...........Qty     Min     Max     Optional 

-OC1       2       2        10 

|__P1      1       1        5         Yes 

|__P2      2       2        10        Yes 

-P3 

8. Add a new part P00001 to M1 Instances table. 
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9. Select P00001 and launch configurator. 

   System correctly returns a browser Warning/Error dialog box with error message: This script 
always throws AgileDSLException. 

10. Close the error dialog. 

11. Select P00001 and launch the configurator again. 

12. System returns the same error as in step 9. 

13. Close the error dialog; Note: No Instance Manager is opened at this point.  User1 can navigate 
to another object. 

14. On another host, login to Web Client with user2. 

15. Retrieve M1. 

16. On M1 Instances table, select P00001 and launch configurator. 

==> System returns Instance BOM is Use error: Instance BOM P00001 is in use by user1. 

Expected: System should return the same error message as in step 9. 

9925470  

Product Collaboration: Instance Manager 

Issue: Validate Variant configuration does not return error if source contains item not in Model 
Option BOM. 

Steps to Reproduce:  

Administrator Configuration: 

1. Configure system with default SPXs or JPXs. 

2. Enable event triggering on the system. This administrator configuration is optional since the 
defect is not event specific. 

Steps: 

1. Create a model M0. 

2.  Add two standard parts to M0 BOM table. 

· P1        (optional) 

· P2        (required) 

3. Add a standard part PART1 to M0 Instances table. 

4. Select PART1 and launch configurator. 

5. In IM, select P1 and click Create Instance. 

6. Close IM. 
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7. Remove P2 from M0 BOM table. 

8. Add a standard part P3 to M0 BOM table. 

9. Add a standard part PART2 to M0 Instances table. 

10. Select PART1 and PART2 then launch configurator (IM). 

11. In IM, click Copy Configuration to copy configuration from PART1 to PART2. 

Bug: In step 11, Validate Variant Configuration is triggered on PART2, but no error message is 
returned even if source configuration contains item not in Model Option BOM (MOB). 

Expected: System should return error message upon Copy Configuration. 

Element in Configuration Draft does not refer to an existing element in the Model_Option BOM, 
element will be removed automatically. After clicking Save as Draft, this error should not appear at 
relaunch. 
 

Product Cost Management 
9226015 

Issue: Min & max value of IPN number flex field in Analysis tab is not considered. 

Steps to Reproduce:  

1. Log in to Java Client. 

2. Open sourcing project > AML tab > Item tab > IPN Number1 and set the Min value as "10" and 
Max value as "100". 

3. Click on Analysis tab and open IPN Number1 and set the Min value as "10" and Max value as 
"1000". 

4. Log in to Web Client, create a sourcing project and add Items and assemblies. 

5. Go to the Analysis tab and do a global select. 

6. Bulk edit on IPN Number1 and enter the value as 125 and click Apply. 

7. Check the IPN Number1 in Analysis tab 

Workaround: Set the Min and Max values same for IPN and MPN flex field. 

9234343 

Web Client (PCM) 

Issue: Between or Not between operator doesn't work as expected for numeric and money 
attributes. 

Steps to Reproduce:  

1. Create a sourcing project. 
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2. Enable AML money/numeric attribute. 

3. Add items with AML to the AML tab. 

4. Do a bulk edit on money/numeric attributes. 

5. Launch Personalization palette and filter number or money attribute with Between or Not between 
as shown below. 

For example: 

AML Number Between 50 and 10. (Give the max value and then the min value.) 

AML Number Not Between 50 and 10. (Give the max value and then the min value.) 

Workaround:  Greater than, less than and other available attributes can be used instead to filter. 

9276900 

Sourcing Project 

Issue: BOMDate attribute does not contain Between and Not between operators in it. 

Steps to Reproduce:  

1. Enable Parts.BOM.BOMDate01 attribute in Java Client. 

2. Create an assembly. 

3. Enter values in parts.BOM.BOMDate01 attribute for BOM items. 

4. Create a sourcing project and add the above assembly applying BOM Filter for item 
BOM.BOMDate01 attribute with match if condition as "Not Between". 

Workaround: Made enhancements to support date filter attribute to support Between and Not 
between operators.  When any of these operators are selected by user, the server expects two 
dates delimited by pipe (|) in Filter.value string through UI.   

9579057 

Reports and Import/Export 

Issue: Unable to edit compare against ref prices page in UCC report after hitting delete key. 

Steps to Reproduce:  

1. Create a sourcing project. 

2. Add an assembly. 

3. Create RFQ and open it to suppliers. 

4. Get response from suppliers. 

5. Run UCC report from the left pane Sourcing reports folders. 

6. Select assembly and price scenarios. 
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7. Add data in compare against reference prices page. 

8. Select any row and hit delete key. Then try to select any other row or try to edit the page. 

Workaround: Using the delete key on the tab resolves this issue, instead of using the Delete key on 
the keyboard. 

9591000 

Sourcing Project 

Issue: Documents are displaying as "part" in CBOM comparison. 

Steps to Reproduce:  

1. Create an assembly with 2 documents as its child. 

2. Create RFQ and get responses from suppliers. 

3. Go to the Analysis tab and do a CBOM. 

Workaround:  No workaround available 
 

9626262 

Sourcing Project 

Issue: All Part and Document Page Two values are not displaying in quick view of item. 

Steps to Reproduce:  

1. Log in to Java Client. 

2. Enable Page Two attributes of document. 

3. Enable Page Two attributes of item. 

4. Enable Sourcing project.AML.Items flex fields and map both Parts.PageTwo attributes and 
Documents.PageTwo attributes. 

5. Create an assembly and add a part and a document as children. 

6. Enter values for all the Page Two fields for part and the document. 

7. Create a sourcing project and add the above assembly. 

8. Invoke the quick view of part or document. 

9626845 

Supplier 

Issue: User is not able to select ORACLE list value in organization list of discussion. 

Steps to Reproduce:  

1. Enable Oraganization field from Java Client > Admin > Data Settings > Classes > Activities > UI 
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Tabs > Discussions. 

2. Now in Web Client, create a discussion. 

3. Click on Edit and try to edit ORACLE value into organization list. 

Workaround: Set display type of Organization list from Search to List in Java Client. 

9643227 

Sourcing Project 

Issue: IPN/MPN's are not in sorted order in Analysis tab > Apply Price Adders page 

Steps to Reproduce:  

1. Create sourcing project. 

2. Add assemblies, Item with AMLs. 

3. Create an RFQ and open it to suppliers. 

4. Get responses from suppliers. 

5. Go to Analysis tab and click on Apply Price Adders > By Part from Analyze menu. 

6. Check the order of IPN/MPNs. 

9696703 

Sourcing Project 

Issue: RFQ owner value is missing in the RFQ export for non-Web supplier. 

Steps to Reproduce:  

1. Create a non-Web supplier. 

2. Create a sourcing project and add an assembly. 

3. Create a RFQ and add the above non-web supplier. 

4. Go to Response Status tab and export the RFQ. 

5. Open the Export file and check the Owner column. 

9821589 

Sourcing Project 

Issue: Moving fields from displayed to hidden does not work in Discussion tab > Format 

Steps to Reproduce:  

1. Create a sourcing project. 

2. Go to Discussion tab. 
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3. Create a discussion and click on Personalization. 

4. Move a few fields from Displayed fields to Hidden fields and click on Apply. 

5. Check the fields that were moved to hidden field. 

Workaround: No workaround.  The user cannot hide any attribute column on the Discussion tab. 

9887049 

Web Client (PCM) 

Issue: Hidden fields in the Attachments tab are not displayed after refresh or any operation. 

Steps to Reproduce: 

1. Create a sourcing project. 

2. Add attachments to it. 

3. Go to Personalization palette > Format tab and hide a few columns. Apply and close. 

4. Refresh the Attachments tab. 

5. Launch Personalization palette > Format tab.  

Workaround: To view the hidden columns, the user needs to log out and log in again 
 

Product Portfolio Management 
9303448 

Synchronization with MS Project 

Issue: Effort-based completed child is displayed as zero duration in Microsoft Project. 

Steps to Reproduce: 

1. In Web Client, create an effort-based activity with effort-based tasks T1 & T2. 

2. Add resource to Team tab of root with % allocation by checking Apply to this level and below 
checkbox. 

3. Complete T1 and launch it in Microsoft Project in Edit Mode from root and check the duration of 
T1. 

Note: It is displayed as zero duration and if we try to publish without doing any change, the system 
gives an error message. 

9406395 

Synchronization with MS Project 

Issue: SOLARIS X86 -CLUSTER- IIS6.0 Proxy with SSO-WINDOWS NTLM. - Not able to publish 
the activity from Microsoft Project. 
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Steps to Reproduce: 

1. In Web Client, create a Project. 

2. Launch MS Project in Edit Mode from Actions menu. 

3. Add a few tasks to the Project, and publish to PPM. 

Note: Replace Authentication is required even though it is SSO. 

9843295 

Gantt Chart 

Issue: Time picker is not displayed in Gantt while executing parametric search on date. 

Steps to Reproduce: 

1. In Java client, enable Activities class General Info. Schedule Start date for search criteria. 

2. Log in to Web Client. 

3. Create a project P1 with schedule start date = current date 8:00 AM time. 

4. Launch Gantt chart for any project and go to File menu - Open. 

5. Search for Activities using parametric search with search criteria: Schedule Start date Equal To 
Current date. 

Note: While specifying date there is no time picker. Whereas, in Web Client the time picker is 
displayed, hence there is an inconsistency in behavior. 

9922981 

Gantt Chart 

Issue: In Gantt, the weekend warning message pops up twice in Insert Activity/Gate dialog. 

Steps to Reproduce: 

1. Log in to Web Client. 

2. Create a project P1. 

3. Launch Gantt chart for P1. 

4. In Gantt, add subtask T1 using Insert Activity (CTRL +ALT+A). 

5. Select weekend day as Schedule Start/End Date. 

Note: The weekend warning message gets prompted twice. The same is true in the Insert Gate 
dialog (Ctrl+ Alt + G). 

Workaround: User has to click twice on warning OK button. 

9945695 
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Web Client (PPM) 

Issue: Personalize in My Assignment is not working for multi-list type attributes. 

Steps to Reproduce: 

1. Navigate to My Assignments. 

2. Select Personalize and select filter. 

3. Set the query based on multi-list say status in closed. 

4. Save and enter the name and save. 

5. Open the base view. 

6. Open the newly created view. 

Note: The values are not filtered based on filter set and also the values are not retained. The same 
is true for category fields configured to My Assignment. 

Workaround: Do not create views with multi-list and category field attributes. 
 

9953349 

Import/Export (PPM) 

Issue: Not able to import new dashboard category fields. 

Steps to Reproduce: 

1. Log in to Web Client. 

2. Select import from the Tool and Settings menu. 

3. Select the file and click next and next again. 

The new dashboard category fields are not displayed under Agile fields. 

Workaround: New Dashboard category fields introduced in 931 are not supported in Import. 

9966696 

Web Client (PPM) 

Issue: Creating project on weekend day will have weekend day as default schedule date. 

Steps to Reproduce: 

1. Log in to Web Client on a weekend day. (Saturday or Sunday as set in Agile.Properties). 

2. Create a new project and check the default Schedule Start and End dates in Create New project 
dialog. 

3. Default Schedule Start and End dates will be weekend date with duration as 1 day. If user 
continues to create with default dates, it doesn't prompt any warnings for weekend date selection. 
This is also true for the Gantt chart. 
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Workaround: This is deviation from normal behaviour in the sense that there will be no warning but in 
case of edit and update of dates, a warning message would appear. 

9967330 

Gantt Chart 

Issue: In Gantt, cannot save Actual Start Date to any date ahead of current date from Project 
Information wizard. 

Steps to Reproduce: 

1. Log in to Web Client. 

2. Create a Project P1. 

3. Launch Gantt chart. 

4. In Gantt, invoke Project Info. wizard for P1. 

5. Edit Actual Start Date field and select any date ahead of current date in calendar and come out of 
edit mode. 

Result: Actual Start Date field will be blank. Selected date from calendar is not getting filled in. 

Workaround: Edit of Actual Start Date can be done by inline edit of Actual Start Date column. 

9970785 

Schedule Management 

Issue: Successor task's schedule date goes wrong on upgrade to 931      

Steps to Reproduce: 

1. Log in to Web Client. 

2. Create a project P1 and add subtask T1, gate G1 and another subtask T2 with schedule 
Startdate as current date and duration as 1 day. 

3. Create Finish-Start (FS) type dependency between task T1 & gate G1 (G1 as successor) with 
Time buffer = 1. 

4. Create Finish-Start (FS) dependency between gate G1 & task T2 (T2 as successor) with Time 
buffer = 1. 

Result: In PLM 9.2.2.4, this scenario results in the Root project's schedule duration as 3 days. 
Whereas, in 9.3.1, schedule duration of root project will be 4 days.  

Workaround:  

There is no workaround for this. In such scenario, customer will have to contact Oracle Support. 
This is also documented in Upgrade documents.  
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Product Governance and Compliance 
9345111 

Issue: Supplier user should change password while opening Assembly from Excel integration. 

Steps to Reproduce: 

Preliminary: Supplier user should change password while opening assembly / Submitting Response 
/ Opening Request from Excel Integration. 

1. Force Supplier user "minye" to change password upon next login, assign all "(Restricted)" roles 
for this user. 

2. Set correct address for Rollup in Excel and Open in Excel process extensions (PX), add Rollup in 
Excel as PX of Items base class. 

3. Log in to Web Client as admin. 

4. Search a part, click Actions > Rollup in Excel. 

5. After the spreadsheet is downloaded, Agile > Open Assembly, "minye" logs in to the system, 
there is no page to allow the user to change password. 

Procedure: 

1. Log in to Web Client using admin. 

2. Create a Declaration using supplier1. 

3. Open the Declaration to Supplier user. 

4. "minye" logs in, and opens the Declaration. 

5. Click Actions > Open in Excel. 

6. Do as tips, close Web Client.  

7. Log in to Java Client as administrator, open "minye" Supplier user, set so "minye" must change 
the password upon next login. 

7. After the spreadsheet is downloaded, click Agile > Open request or submit response. 

8. In the login page, use "minye" login, system should prompt the user to change the password. 
 

Recipe & Material Workspace 
9298696 

Agile Installer and Recipe & Material Workspace 

Issue: Recipe & Material Workspace cannot be installed in an Agile cluster. 

Workaround: None. Future releases will add support for clustering. 
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9345389 

A9-Pharma Integration 

Issue: Preferred currency is not available to map in the config file. 

9358368 

A9-Pharma Integration 

Issue: Description of material updated to Agile despite failed publish. 

Steps to Reproduce:  

1. Create a Material in RMW with Description and push it to Agile by triggering the Daemon/Service. 

2. Material gets created in Agile. 

3. In Agile, create a change order on the Material, so Material in Agile will have pending changes. 

4. In RMW, move back the status of the Material to Draft and Change the Description of the 
Material. 

5. Trigger the Daemon/Service by moving the status of the Material to Approved. 

6. Publish fails, but description (Changed description) is still updated in Agile. 

9397976 

A9-Pharma Integration 

Issue: Update of User ID is not proper in integration. 

Steps to Reproduce: 

1. Create a User in Agile with all the required fields, including User ID, First Name, Last Name, 
Default Site, etc. 

2. User is automatically created in RMW. 

3. In Agile, change the User ID and save the changes. In RMW, User ID is not updated 

4. Again, in Agile, change the User ID and save the changes. In RMW, the previously made 
changes are updated. 

9401587 

A9-Pharma Integration 

Issue: When User in PLM is undeleted (changed from Inactive back to Active), in RMW the User 
status does not change to Active. 

Steps to Reproduce: 

1. In Agile Java Client, create a user with required values. 

2. User is automatically created in RMW. 
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3. In Agile Java Client, delete the user (by clicking Delete icon). 

In PLM, status of the user changes to Inactive. In RMW, status of the user changes to Inactive. 

4. In PLM, change the user's status to back to Active. 

In RMW, the status of the user is not changed. 

Workaround: After (deleted, Inactive) user is changed to Active (undeleted) in PLM, perform a 
manual synchronization: the user in RMW is changed to Active. 

9453732 

A9-Pharma Integration 

Issue: Not able to navigate to RMW from Agile when we log in as LDAP user  

Steps to Reproduce:  

1. Configure LDAP Server to Agile, migrate the user to Agile. 

2. Assign all required roles to the LDAP user. 

3. Login to Agile as LDAP user. 

4. Try to Navigate to Pharma. 

9533895 

UI Components-Framework 

Issue: Filter on text fields should either use Starts With or Contains, not Equal-to. 

Steps to Reproduce:  

1. Log in to A9 and switch to RMW. 

2. Execute search and in the search results table click on Filter. 

3. On any text field enter some part of the text and click on filter and you will see that no rows are 
displayed even though there are valid matches. 

Workaround: Use a wild card character like * at the end of the text used to filter the rows. 

9558112 

Analytical 

Issue: Warning should display while adding a sample without result to lot release process. 

Steps to Reproduce:  

1. Navigate to Create New:Analytical: Lot Release Process. 

2. In General Page, select the Source Inventory ID with the look up icon for which samples (doesn't 
have any result) are present and enter the Start Evaluation date as the current date, Evaluation 
Type=Blanket  and click on Next 
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3. Select a Sample & Click on next 

4. Click on Finish. 

Issue: Not showing any warning Message 

Expected Result: A Warning message should be displayed, if the samples displayed under the 
Samples tab do not have Results entered. 

9626098 

Users, Roles, User Group, Contacts 

Issue: Logging into RMW application with locked user is allowed 

Steps to Reproduce:  

1. Manage and search for a user. 

2. Search results, select a row and click Lock option from the More menu. 

3. Log out from the application and log in as locked user. 

9643855 

Recipe 

Issue: Level of indentation, if not proper when specification plans are inserted to Material 

Steps to Reproduce:  

1. Create a Recipe. 

2. Add a Recipe Action Template (RAT) in the SFC Editor (RAT should have Material variable) and 
click on Next. 

3. Resolve the Variables in the BOP tab. 

4. Navigate to specification plan tab of BOM tab. 

5. Select the Material variable and click on Add Specification Plan button. 

6. Add multiple specification plans. When 2 or more specification plans are inserted, then the first 
inserted specification plan is inserted below the Material variable (which is correct) but the other 
specification plans are showing in the level as that of the Material.  

Workaround: Users can put all their parameters into 1 spec plan as a work around. 

9663282 

Process 

Issue: On Bill Of Equipment > Contaminant sub-tab of Control Recipe, the variable names are not 
live links. 

Steps to Reproduce: Go to Control Recipe Edit or View details page, here go to BOE->Contaminant 
subtab, where variable names are not clickable. We have to make them clickable to navigate to the 
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variable details page. 

Workaround: Have to click from Resources tab. 

9686722 

Metamodeling 

Issue: The Aggregation function does not work. 

Steps to Reproduce:  

1. Navigate to Object Modeling > Views > New. 

2. Select the Material Category and click on Next. 

3. Enter the View name, allow Tree view=Yes and other mandatory data and  click Next. 

4. Select the categories to provide the attributes and click Next. 

5. Select the required attributes to be displayed in Search view and results view and click Next. 

6. Specify the display name, order and description for the search attributes and click Next. 

7. Enter the required data. 

8. Select any number attribute (for example Salary attribute from employee tab, which has Dept 
attribute based on which we can aggregate the data) and click on Aggregate  > Add. 

9. Enter the Aggregate using: Dept Aggregate Function: Sum, and click on OK button. 

10. Click Next. 

11. Specify the tree level and check "use in tree" for the required attributes and click Next. 

12. Specify the display order and display level and click on Finish. 

13. Do the custom search on the category on which the view has been created above, click on 
search tab, and select the view created above in the view drop down box. 

14. Click on the Search button. 

9687981 

Recipe 

Issue: Cannot remove multiple variables in Output tab of new recipe. 

Steps to Reproduce:  

1. Create new Recipe. 

2. Add a Recipe Action Template (Add a Recipe Action template with 2 or more Output Variable) in 
SFC Editor screen. 

3. Navigate to Output tab of the Recipe. 

4. Select Multiple Variables. Remove Button is not enabled when multiple Vairables are selected. 
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Workaround: Users can do it one at a time. 

9695561 

SFC Editor Module 

Issue: System shouldn't allow Delete/Create connection on expanded elements on SFC. 

Steps to Reproduce:  

1. Log in to A9 and switch to RMW. 

2. Search for Recipe or Recipe Element Templates (RET), select one with elements that have child 
elements or action and edit. 

3. Launch SFC Editor. Expand an element with child elements or actions. 

4. Select a node within the expanded element and hit the Delete button and you will see that the 
node gets removed and if you attempt to create the connection, you will see that it looks as though 
it creates the connection, but the remaining nodes remain unconnected. 

Workaround: Select the node, select Traverse Down, and make changes such as delete nodes or 
create connections. 

9697774 

Process 

Issue: Allowing to record results more than maximum number set in Parameter Result tab 

Steps to Reproduce:  

1. Search for Work Order. 

2. Select one and click on More >Record Results action. The record results page appears.  

3. Select parameter variable and create more than maximum number of results set for it, now click 
OK. It saves, although it should not since maximum number of results have been met. 
 

9701008 

A9-Pharma Integration 

Issue: XML/PDF attachment is not added to the target material when BOM, BOE, and tabs contain 
data. 

Steps to Reproduce:  

1. Create a Recipe Action Template (RAT) with Material Variable, Equipment Variable and 
Parameter, and approve the RAT. 

2. Create a Recipe by using the RAT created above. 

3. Resolve the Variables and approve the Recipe. 

4. Trigger the Daemon/Service. 
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5. Recipe Integration successful. 

9713129 

SFC Editor Module 

Issue: When all nodes in branch are removed, the branch nodes remain on SFC. 

Steps to Reproduce:  

1. Log in to A9 and switch to RMW. 

2. Search for recipes. 

3. Select one with conditional and parallel branches and edit. 

4. Launch SFC, select all nodes in both conditional and parallel branches and remove them and you 
will see that the branches still remain in SFC and that they have to be explicitly removed. If you 
attempt to connect the end of a parallel branch to the start of the conditional branch, you will see 
that it allows the connection even though there are no nodes in the branch. 

Workaround: Remove nodes one at a time. 

9780869 

Material 

Issue: Script error in Container details. 

Steps to Reproduce:  

1. Login as administrator. 

2. Click on Create New > Materials > Receiving. 

3. Select Vendor and click Next. 

4. Add 5 Materials and Enter Lots as 5 and click Next. 

5. Enter the lot numbers and click Next. 

6. Enter Quantity received as 5 and Number of Containers as 5 for each lot. Click Next. 

7. Now click Find icon next to storage location. 

8. Select a storage location and click OK. You will get a script error. 

Workaround: Issue occurs only when receiving is for more than 40 containers. Normal use case up to 
10 containers works fine. 

9785144 

UI Components - Framework 

Issue: Hidden columns on Search results table are showing up when status is changed. 

Steps to Reproduce:  
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1. Execute the search for objects having statuses like Control Recipe (CR). 

2. Hide a couple of columns. 

3. Select one CR and change status. 

9797158 

Analytical 

Issue: High memory usage whenever we add a new row in a grid. 

Steps to Reproduce:  

1. Log in to RMW. 

2. Create new Analytical > Sample. 

3. Provide necessary details and move on to Containers tab - where we have the grid table. 

4. At this point note down the browser memory. 

5. Add 10 rows by clicking on add row button 10 times. The browser memory shoots from 
approximately 90 MB to 228 MB. 

6. Add a container location using the lookup for one row and after that is done, the browser memory 
reaches 256 MB and at this time all the actions become slow. At an average, every time we add a 
row it is consuming around 10-12 MB. 

Just consider a use case of creating 10 rows and selecting the container locations. 

9817566 

Metamodelling 

Issue: Composite Key tab is not displaying in the edit mode of a category from search. 

Steps to Reproduce:  

1. Navigate to Category Manage and select Equipment:Pump from Browse tab. 

2. Click on the Attributes tab: Composite Key tab and create a composite key. 

3. Click on Search tab and search for the Pump category in the Name field. 

4. Select the category Pump and click on Edit button. 

5. Navigate to Attributes tab of category. 

Note: Composite key tab is not displaying in Edit mode. 

Workaround: Composite key tab can be edited using Browse tab. 

9866263 

SFC Editor Module 
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Issue: After creating connection, unconnected nodes that were moved earlier are getting reset. 

Steps to Reproduce:  

1. Log in to A9 and switch to RMW. 

2. Launch Recipe Creation wizard. 

3. Launch SFC Editor, add around 8 or 10 actions and you will see that the boxes are placed 
horizontally, thus they are very small and user will have no clue what they read, so they are forced 
to zoom-in in order to be able to read names off these actions. After connecting a few, the chart 
runs off the visible area and in order to continue, they are now forced to use pan. If they pan, they 
don't see the unconnected nodes because they are at the top, so they fit-in- canvas or auto layout, 
select the unconnected nodes and move them down, so that they can again zoom and pan to 
connect. All looks good until they connect the first node, after which all the connected nodes move 
back to the top and they have to keep doing this, fit-in-canvas, move, zoom, connect and repeat.  

Workaround: The work around is to connect the nodes in multiple groups and then connect the 
groups instead of connecting all the nodes sequentially in one attempt. 

9872433 

Recipe 

Issue: In the lookup of Specification Plan, parameter older version spec plans are also seen. 

Steps to Reproduce:  

1. Navigate to Create New: Recipe: Action Template. Enter data and click Next button. 

2. Click New Parameter icon. 

3. Select Copy spec plan parameter radio button. Click the lookup icon. 

Issue: The results show the old and new specification plan and as a result the same parameter is 
displayed twice. 

Workaround: User has to be careful in selecting the latest version specification plans. 

9890726 

Process 

Issue: More and Change actions are missing on Process Step tab of Edit Campaign. 

Steps to Reproduce: 

1. Login to A9 and switch to RMW. 

2. Search for campaigns, select one and click on Manage Process Step action. 

3. Make a note of all the actions displayed on the actions tool bar. 

4. Now search for campaigns again, select the same and edit. 

5. Switch to Process Steps Tab and you will see that only New, Edit and Delete actions are 
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displayed and the rest of actions we saw on step 3 are not available on this table. 

Workaround: The More and Change actions can not be done in Edit Campaign, but can be 
performed from "Manage Process steps". 

9921645 

Material 

Issue: Material name is not unique - as a result the same material has different characteristics. 

Steps to Reproduce: We allow material name to be the same since ID is generated uniquely. This is 
causing some other errors downstream - for example there are 3 instances of sulphuric acid, each 
with different densities. While resolving the material variable, if user selects wrong definition of 
material, it causes wrong data to be used and to appear in recipe. Therefore Material Name should 
be unique. Same goes with Equipment Name, and Recipe/RAT/RET name. 

9922489 

Material 

Issue: Recipe has unresolved BOMs when integration triggered by changing name. 

Steps to Reproduce:  

1. In RMW, Create a Recipe and add the Recipe Action Template (RAT) created. 

2. Resolve the Variables and approve the recipe. 

3. Trigger the Daemon/Service. The recipe gets created in Agile. 

4. In RMW, select the recipe created and click on Edit >New Version. 

5. In Edit as New version, click on Save and Edit button. 

6. Change the Name of the Recipe and click on OK. 

7. Approve the Recipe. 

8. Trigger the Daemon/Service. 

Recipe Integration fails with Integration message "The recipe has unresolved BOM(s)". 

Workaround: Whenever there is a need to change the recipe name of an approved Recipe use "Save 
As" on it instead of moving it to draft and changing it in new version of new object. 

9926198 

Process 

Issue: Control Recipe view details: operating mode and scale factor attributes are missing. 

Steps to Reproduce:  

1. Search under Process > Control Recipe. 

2. Locate a Control Recipe and go to View Details. 
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Issue: Verify 'Operating mode and Scale factor' attributes are missing under the General tab, but 
they are seen in the Edit Control Recipe page. 

Workaround: We can see the Operating mode and Scale factor attributes in Edit Mode. 

9928209 

Process 

Issue: Final print to PDF doesn't include page number on Work Request, Control Recipe, or Recipe 
objects. 

Steps to Reproduce:  

1. Log in to A9 and switch to RMW. 

2. Search for recipes, select one and click on Print. 

3. In the print page, select final option, enter file name and finish the wizard. 

4. Download and open the PDF file and you will see that the page number is missing, but if we print 
as Draft, the page number is displayed properly. 

Note that the same issue applies to Control Recipe, Work Request, and Recipe objects. 

Workaround: Page numbers are displayed in the Draft mode. 
 

9930070 

Recipe 

Issue: Recipe Element Template (RET): Resources tab: Unable to edit the parameter in the 
following scenario 

Steps to Reproduce:  

1. Create a Recipe Action Template (RAT) with 1 variable and 1 parameter. 

2. Navigate to Create New: Recipe Element Template. Enter mandatory data and click the Next 
button. 

3. Add 2 instances of above created RAT through Edit SFC button and click the Next button. Merge 
variable popup shows up. Click OK on popup. 

4. Under Resources tab, select the parameter of 1st RAT and click the Edit button. 

Issue: The page gets refreshed and the same page is seen, however, the user is able to edit the 
parameter of the 2nd instance RAT. 

Workaround: Parameter can be edited from RA edit screen also 

9930082 

Recipe 

Issue: Extra entry of parameter is seen when user edits parameter during merge variables. 
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Steps to Reproduce:  

1. Create a Recipe Action Template (RAT) with variable V1 and parameter P1. 

2. Navigate to Create New: Recipe Element Template. Enter mandatory data and click the Next 
button. 

3. Add 2 instances of above created RAT through Edit SFC button and click Next button. Merge 
variable popup shows up. Click OK on popup. 

4. Under Resources tab, select the parameter of 2nd instance RAT and click edit. 

5. In the edit page associate variable V1 and save the changes. 

Issue: For the first instance RAT, 2 parameters are seen, one associated with variable, and the 
other with no association. 

9945444 

Recipe 

Issue: Recipe Action Template (RAT): Instructions area removing first variable moves the second 
variable as well. 

Steps to Reproduce:  

1. Navigate to Create New: Recipe Action Template. Enter data and click Next. 

2. Define 3 variables V1, V2, V3 in the instruction area through New variable icon without any space 
or comma. 

3. In the instructions areas, select the first variable and click Delete. 

Issue: V1 and V2 variables are removed. 

Workaround: Create variables with space or comma. 

9964856 

UI Components - Framework 

Issue: Search results table UI gets messed up when filter doesn't return any matched rows. 

Steps to Reproduce: 

1. Login to A9 and switch to RMW. 

2. Execute custom search for materials. 

3. Once search results table is displayed, click on filter icon and type-in "Test" on filter input field on 
Category column and click on Filter. 

4. When the search results table is refreshed, you will see that there is no horizontal scroll bar and 
there is no way for the user to remove the filter criteria text on Category field and get back to the 
normal search results. 
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Workaround: Click on clear button and then click on filter button again, which will display the table 
properly and user can filter on some other criteria. 

9964939 

UI Components - Framework 

Issue: Second time change status on home page leads to not handled the response type error 

Steps to Reproduce: 

1. Login to A9 and switch to RMW. 

2. Go to User Preferences and add either Projects or Campaigns to the home page. 

3. Log out and log in and make sure that the added channel is displayed properly on the home 
page. 

4. Select a row and click on Change action and note that it is working properly. 

5. Now unselect the row, select it again and click on Change action and you will see that it leads to 
an error. 

Workaround: Load the home page again and try the action. 

9965120 

UI Components - Framework 

Issue: Filter on Search results table applies to all rows instead of rows that met criteria. 

Steps to Reproduce: 

1. Login to A9 and switch to RMW. 

2. Execute quick search for any type of object with some criteria that would result in a sub-set of the 
objects. (Note that the issue applies to custom search results, as well.) 

3. Click on the filter icon on search results table, enter filter criteria on a field and click on filter 
action and you will see that the filter criteria is applied on all rows instead of the sub-set of rows 
returned as a result of search executed on step 2. 

Workaround: Apply filter on multiple files in order to filter down to a sub-set of objects. 

9971696 

Recipe 

Issue: Unable to add criteria after deleting the existing criteria. 

Steps to Reproduce:  

1. Navigate to Create New: Recipe: Action Template. 

2. Create a Recipe Action Template (RAT) with a variable in which criteria is defined. 

3. Locate the above created RAT and click edit button. Go to Instructions tab and edit the variable. 
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4. Go to the Criteria tab and delete the existing criteria. 

5. Click the New button. 

Issue: An error message "Only one criteria is allowed for a variable is seen." 

Workaround: Criteria can be created from Edit page. 

9975909 

Administration 

Issue: Workflow signature table does not display the role of the user who approved. 

Steps to Reproduce: 

1. Create a Workflow with a state that requires multiple roles for signature (3 for example). 

2. Release the Workflow and approve it. 

3. Perform action on object to trigger the workflow. 

4. Log in as Role 1 and 2 and approve the task. 

5. Now check the "task : Authorized Parties" tab.  

Error: The display does not have column for the Role performed by the user at approval. It should 
also show which roles have and have not been approved.  

9976025 

Process 

Issue: Request inventory from process step brings over consumables into the material list. 

Steps to Reproduce:  

1. Go to process step - request inventory. 

2. The BOM + Consumables show up on the Allocation Request Material List. 

3. Fill in quantities required, and need by date. 

4. When you are about to save the allocation request, you get the error "Consumables are not 
allowed." 

10007277 

Process 

Issue: If consumables are used on a process step or Work Request, then they show up correctly 
listed. 

Steps to Reproduce: Allow users to consume consumables at the Work Request level, or don't show it 
on the screen with the actions enabled. Currently the action buttons are enabled when a 
consumable row is selected. 
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10007317 

Process 

Issue: Work order printout does not contain all of the correct columns. 

Steps to Reproduce: Review the content of the Work Order printout. For example, it does not contain 
the material lot/container/consumption information.  

10016535 

Alerts Engine & Notifications 

Issue: Edit alert - Changes made to the notification methods are not saved. 

Steps to Reproduce: 

1. Navigate to Alert Manage screen. 

2. Select a pre-defined alerts and unpublish it. 

3. Edit the unpublished alert. 

4. In alert Edit page, activate "Notification" tab. 

5. Change primary & optional notification methods. 

6. Click OK to save changes. 

7. Open the same alert in edit mode and check the notification methods. 

Error: Changes done in step 5 are not saved. 

10026958   

AT, RA, RET, RA, Recipe, SFC 

Issue: Variable criteria isn't saved if default view is displayed in the criteria page. 

Steps to Reproduce: 

1. Log in to A9 and switch to RMW. 

2. Create a new Recipe Action, add an equipment variable at Dryer or Blender level and add a 
standard variable at Cautions level. 

3. Now select the equipment variable and edit. 

4. Switch to criteria tab, create a new criteria. 

5. Click on next, select value for a few fields on the Criteria page and click on OK. 

6. Select the newly created criteria and edit, and switch to Criteria tab and you will see that none of 
the criteria values were retained. 

The same issue can be reproduced with standard variable as well. 
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Workaround: 1: Variable Criteria can be added only to non-default views. Please create a non-default 
preferred view for new Categories that are added to the application. 

2: Add To Favorites button does not work on Variable Criteria definition screen. 

10032607 

AT, RA, RET, RA, Recipe, SFC 

Issue: Parameter is not copied if user selects a variable associated with param thru 'Use Copy'. 

Steps to Reproduce: 

1. Search under Recipe > Library. 

2. Select a Recipe having multiple Recipe Action Templates (RAT) added in the SFC (The variable 
associated with parameters should be present in the RATs.) 

3. Edit the Recipe. Click BOP page. Select a RAT and click Edit. Select the Instructions tab. Click 
Show Variables list. 

4. Click the Add from This template option. 

5. Select a variable associated with parameter and click 'Use Copy' button. 

6. Warning popup to copy the parameters will be seen. Select the parameter and click OK on 
popup. 

7. Insert the copied variable into the instructions area. 

8. Click "Show parameter list" button. 

Issue: Verify the copied parameter is not seen in the list. 

Workaround: After adding the variable through "Use copy" the user can add the parameter. 

10044504 

AT, RA, RET, RA, Recipe, SFC 

Issue: Recipe element from selection leads to application error for a Recipe Action (RA) having a 
variable and parameter. 

Steps to Reproduce: 

1. Navigate to Create New > Recipe > Element Template. 

2. Create a Recipe Element selecting a Recipe Action having a variable and parameter. 

3. Locate the Recipe Element and click Edit. Go to SFC, select the RA and create an element from 
selection. Come back to instructions tab. Click the OK button. Application error is displayed. 

Workaround: Use the Recipe Element in a Recipe and then the user can create an element from 
selection. 

10051155  
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Integrations 

Issue: RMW Export/Import (ExIm) exporting function does not work on Oracle Application Server 
(OAS). 

Steps to Reproduce: (Note that the issue only applies to OAS application server environment). 

1. Update the <object>_criteria_properties.xml file under EXIM templates folder for the 
object type that you want to export. 

2. Run the export.bat with proper input parameters and you will see that it does not work and 
throws an exception. 

Workaround: Update the the CLASSPATH on export.bat inside EXIM bin folder to include 
;%OAS_LIB%\lib\ejb.jar;%LIB%\xalan-2.7.0.jar; 

10051180 

Integrations 

Issue: For RMW Export/Import (ExIm), incorrect Material, Equipment names in criteria files cause 
export operation to fail. 

Steps to Reproduce: Access the EXIM criteria files for Material and Equipment libraries and you will 
see that the attribute name is incorrect. 

For example, in mat_library_criteria.xml, the Material name attribute should be 
$$_A_MAT_MATERIAL_NAME whereas it is $$_A_MATERIAL_NAME.   

Note that similar issue exists on Equipment criteria file as well. 

Workaround: Edit the corresponding criteria files and fix the Name attribute to 
$$_A_MAT_MATERIAL_NAME for Material library, and likewise for Equipment library. 

10107452 

Integrations 

Issue: Supplier integration fails when the Supplier site added to a Site Qualification does not have a 
parent site. 

Workaround: Use a Supplier site that has a parent site. 
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